Copyright and Trademark Information
This document and all its contents herein are subject to and protected by international copyright and other intellectual property rights
and are the property of Nero AG and its subsidiaries, affiliates or licensors. All rights reserved. No part of this document may be
reproduced, transmitted or transcribed without the express written permission of Nero AG. All trade names and trademarks and/or
service marks are the property of their respective owners. The trademarks mentioned are expressly named for information purposes
only. Nero AG rejects any claims that transcend the clauses of the guarantee rights to the fullest extent. Nero AG does not undertake
any liability for the correctness of the content of this document. The contents of the software supplied, as well as of this document,
may be changed without prior warning. Some applications of the Nero Suites require technologies developed by third-party
manufacturers. These technologies need to be activated online (free of charge) or by sending an activation fax to have unlimited use
of the respective functionality. Nero will then undertake to release the data necessary to activate technologies licensed by third-party
manufacturers for use with the product. It is therefore necessary to have an Internet connection or a fax machine.
Unless you own the copyright or have permission from the copyright owner, you may be violating national or international copyright
laws and be subject to payment of damages and other remedies, if you duplicate, reproduce, modify, or distribute copyrighted
material. If you are unsure of your rights you should contact your legal advisor.
Copyright © 2014 Nero AG and its licensors. All rights reserved.
Nero, Nero BackItUp, Nero Digital, Nero Simply Enjoy, Nero SmoothPlay, Nero StartSmart, Nero Surround, Burn-At-Once,
LayerMagic, Liquid Media, SecurDisc, the SecurDisc Logo, Superresolution, UltraBuffer, Nero Burning ROM, Nero Express, Nero
BurnRights, Nero ControlCenter, Nero CoverDesigner, Nero Blu-ray Player, Nero WaveEditor, Nero SoundTrax, Nero BurnRights,
Nero SoundTrax, Nero BackItUp, Nero Video, Nero Recode, SecurDisc Viewer, Nero RescueAgent, Nero AirBurn, Nero MediaHome
Receiver, Nero Disc to Device, Nero MediaBrowser, Nero MediaHome, NeroKwik, Nero MediaHome WiFi Sync, Nero
MediaHomeUnlimited, Nero MediaHome Burning, Nero MediaHome Playback, Nero MediaHome DVD Pack, Nero MediaHome
Sync, Nero MediaHome Streaming, Nero MediaHome HD Burn, Nero MediaHome Faces, Nero MediaHome Play to TV and Nero
Themes are common law trademarks or registered trademarks of Nero AG.
Portions of the Software utilize Microsoft Windows Media Technologies. Copyright © 1999-2002. Microsoft Corporation. All Rights
Reserved.
This product contains portions of imaging code owned by Pegasus Software LLC, Tampa, FL.
Gracenote, CDDB, MusicID, MediaVOCS, the Gracenote logo and logotype, and the "Powered by Gracenote" logo are either
registered trademarks or trademarks of Gracenote in the United States and/or other countries.
Manufactured under license from Dolby Laboratories. Dolby, Pro Logic, and the double-D symbol are registered trademarks of Dolby
Laboratories, Inc. Confidential unpublished works. Copyright 2011 Dolby Laboratories. All rights reserved.
AVCHD and AVCHD logo, AVCHD Lite and AVCHD Lite logo are trademarks of Panasonic Corporation and Sony Corporation.
Facebook is a registered trademark of Facebook, Inc.
Yahoo! and Flickr are registered trademarks of Yahoo! Inc.
My Space is a trademark of MySpace, Inc.,
Google, Android and YouTube are trademarks of Google, Inc.
The Android robot is reproduced or modified from work created and shared by Google and used according to terms described in the
Creative Commons 3.0 Attribution License.
Apple, Apple TV, iTunes, iTunes Store, iPad, iPod, iPod touch, iPhone, Mac and QuickTime are trademarks of Apple Inc. registered
in the U.S and other countries.
IOS is a trademark or registered trademark of Cisco in the U.S. and is used by Apple under license.
Blu-ray Disc, Blu-ray, Blu-ray 3D, BD-Live, BONUSVIEW, BDXL, AVCREC and the logos are trademarks of the Blu-ray Disc
Association.
DVD Logo is a trademark of Format/Logo Licensing Corp. registered in the U.S., Japan and other countries.
Bluetooth is a trademark owned by Bluetooth SIG, Inc.
The USB logo is a trademark of Universal Serial Bus Implementers Corporation.
ActiveX, ActiveSync, Aero, Authenticode, Bing, DirectX, DirectShow, Internet Explorer, Microsoft, MSN, Outlook, Windows, Windows
Mail, Windows Media, Windows Media Player, Windows Mobile, Windows.NET, Windows Server, Windows Vista, Windows XP,
Windows 7, Xbox, Xbox 360, PowerPoint, Silverlight, the Silverlight logo, Visual C++, the Windows Vista start button, and the
Windows logo are trademarks or registered trademarks of Microsoft Corporation in the United States and other countries.
FaceVACS and Cognitec are either registered trademarks or trademarks of Cognitec Systems GmbH.
DivX and DivX Certified are registered trademarks of DivX, Inc.
DVB is a registered trademark of the DVB Project.
NVIDIA, GeForce, ForceWare, and CUDA are trademarks or registered trademarks of NVIDIA.
Sony, Memory Stick, PlayStation, and PSP are trademarks or registered trademarks of Sony Corporation.
HDV is a trademark of Sony Corporation and Victor Company of Japan, Limited (JVC).
3GPP is a trademark of European Telecommunications Standards Institute (ETSI)
Adobe, Acrobat, Reader, Premiere, AIR, and Flash are trademarks or registered trademarks of Adobe Systems, Incorporated.
AMD Athlon, AMD Opteron, AMD Sempron, AMD Turion, ATI Catalyst, ATI Radeon, ATI, Remote Wonder, and TV Wonder are
trademarks or registered trademarks of Advanced Micro Devices, Inc.
Linux is a registered trademark of Linus Torvalds.
CompactFlash is a registered trademark of SanDisk Corporation
UPnP is a registered trademark of UPnP Implementers Corporation.

Nero Burning ROM

2

Ask and Ask.com are registered trademarks of IAC Search & Media.
IEEE is a registered trademark of The Institute of Electrical and Electronics Engineers, Inc.
Philips is a registered trademark of Koninklijke Philips Electronics.N.V.
InstallShield is a registered trademark of Macrovision Corporation.
Unicode is a registered trademark of Unicode, Inc.
Check Point is a registered trademark of Check Point Software Technologies Ltd.
Labelflash is a trademark of Yamaha Corporation
LightScribe is a registered trademark of the Hewlett-Packard Development Company, L.P.
Intel, Intel Media SDK, Intel Core, Intel XScale and Pentium are trademarks or registered trademarks of Intel Corporation in the U.S.
and/or other countries.
MP3 SURROUND, MP3PRO and their logos are trademarks of Thomson S.A.
This product is furnished under U.S. and foreign patents owned and licensed by AT&T Corp.
Other product and brand names may be trademarks of their respective owners and do not imply affiliation with, sponsorship, or
endorsement by owners. Other product and brand names may be trademarks of their respective owners and do not imply affiliation
with, sponsorship, or endorsement by owners.
Nero AG reserves the right to change specifications without notice. Use of this product is subject to the acceptance of the End User
License Agreement upon installation of the software. www.nero.com
Nero AG, Rueppurrer Str. 1a, 76137 Karlsruhe, Germany.
Copyright © 2014 Nero AG and its licensors. All rights reserved.

Nero Burning ROM

3

Table of Contents

Table of Contents
1
1.1
1.2
1.3
1.4
1.5
1.6

Start Successfully
About the Manual
About Nero Burning ROM
Versions of Nero Burning ROM
Working with Nero Burning ROM
Starting the Program
System Requirements

2
2.1
2.2
2.3

User Interface
Main Screen
New Compilation Window
Selection Screen

10
10
13
17

3
3.1
3.2
3.3
3.3.1
3.3.2
3.3.3
3.4
3.5
3.6
3.7
3.8
3.9

Data Disc
Burn CD/DVD/Blu-ray
Burn a SecurDisc
Burn with Nero DiscSpan
Set Nero DiscSpan Options
Creating Multiple Discs with Nero DiscSpan
Copy Data with Nero DiscMerge
Check Point Media Encryption CD/DVD
Saving Data Track
Multisession Settings
Burn with Autorun
UDF Settings
ISO Settings

20
20
22
27
27
28
31
34
34
35
37
38
38

4
4.1
4.1.1
4.1.1.1

Audio CD and Audio Files
Compiling Audio CDs
Customizing Properties of the Audio File
Track Properties Tab

40
40
42
42

4.1.1.2

Indexes, Limits, Split Tab

43

4.1.1.3

Filters Tab

45

4.1.2
4.1.2.1

Defining Options
Audio CD Settings

46
46

4.1.2.2

CDA Settings

48

4.2
4.2.1
4.3

Mixed Mode CD and CD EXTRA
CD-Extra Settings
Gracenote Music Recognition

49
50
51

Nero Burning ROM

7
7
7
8
8
9
9

4

Table of Contents

4.3.1
4.4
4.4.1
4.4.1.1

Identifying Audio Files
Rip Audio CD
Save Audio Tracks to Hard Drive Window
Source Tab

51
52
54
55

4.4.1.2

Output Tab

56

4.5
4.5.1
4.5.2
4.5.3
4.5.4
4.5.5
4.5.6

Encode Audio Files
Encode Files Window
AIFF and WAVE Encoding Options
MP3 Lame Encoding Options
MP3 and MP3PRO Encoding Options
Nero AAC Encoding Options
OGG Vorbis Encoding Options

58
59
60
61
62
64
65

5
5.1
5.2
5.3

Video
Burn DVD-Video
Burn AVCHD
Burn BDMV

66
66
67
70

6
6.1
6.2
6.3

About Bootable Disc
Booting Requirements
Bootable Disc Template
Burn a Bootable Disc

73
73
73
74

7

Burn from Disc Image

76

8
8.1
8.2

LightScribe
Printing LightScribe Label
CD Label Editor Window

79
79
81

9
9.1
9.2

Labelflash
Burn Label Window
Printing Labelflash Labels and DiskT@2

83
83
85

10
10.1
10.2
10.3
10.3.1
10.4

Burn Compilation
Recorder Settings
Burn Settings
Burn Process
SecurDisc Surface Scan Results
Create and Burn a Disc Image

87
87
88
90
92
94

11
11.1
11.1.1
11.1.2
11.2
11.3

Copying a Disc
Methods of Copying
On-the-fly Copying
Copy Over Image
Copy a Disc
Copy an Audio CD

96
96
96
96
97
99

Nero Burning ROM

5

Table of Contents

11.4
11.4.1
11.4.2
11.4.3

Methods and Settings
Image Settings
Copy Options
Read Options

101
103
104
104

12

Erase Rewritable Disc Window

108

13
13.1
13.2
13.3
13.4

About Nero SecurDisc Viewer
Starting Nero SecurDisc Viewer
Copying Data to Hard Drive
Checking Data Integrity
Checking Signature

110
110
111
112
112

14

Nero MediaBrowser

114

15
15.1
15.2
15.3
15.4
15.5

Configuration Options
Compilation Settings
Cache Settings
Expert Features
Ultrabuffer Settings
LightScribe Settings

117
118
119
119
120
121

16

Glossary

122

17

Index

126

18

Contact

129

Nero Burning ROM

6

Start Successfully

1

Start Successfully

1.1

About the Manual
This manual is intended for all users who want to learn how to use Nero Burning ROM. It is
process-based and explains how to achieve a specific objective on a step-by-step basis.
To make best use of this documentation, please note the following conventions:
Indicates warnings, preconditions or instructions that have to be
precisely followed.

Indicates additional information or advice.

1. Start …

The number at the beginning of a line indicates a prompt for action.
Carry out these actions in the order specified.
Indicates an intermediate result.

Indicates a result.

OK
(see…)
[…]

1.2

Indicates text passages or buttons that appear in the program
interface. They are shown in boldface.
Indicates references to other chapters. They are executed as links and
are shown in red and underlined.
Indicates keyboard shortcuts for entering commands.

About Nero Burning ROM
The powerful burning software Nero Burning ROM allows you to burn your data, music and
videos to disc. Nero Burning ROM gives you full, customized control of your burning projects.
You can − among other things − define the file system, the length of the file name and the
character set; you can also change the disc label. And of course, you can also customize the
Nero Burning ROM toolbar and change the keyboard shortcuts.
Despite its wide range of features, Nero Burning ROM has remained an easy-to-use burning
program that creates discs in just a few steps. You select the disc type to be burned
(CD/DVD/Blu-ray), define the project type, add the required data and then start burning.
Using Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the
process, the files are encoded, i.e. converted into a format that the computer can read. The
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Audio CD can be automatically identified with Gracenote. So called metadata such as title,
genre, and track title are accessed by the Gracenote Media Database and associated to the
tracks. That way you have audio files that are accurately and fully named after the encoding
process.
Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

1.3

Versions of Nero Burning ROM
Nero Burning ROM is available as part of Nero 2015, Nero 2015 Platinum and as a
standalone product (Nero Burning ROM 2015).
All versions offer the full range of functions, but Nero Burning ROM as standalone product
does not offer access to Nero MediaBrowser unless Nero MediaHome is installed.
You can always upgrade your standalone version to Nero 2015 or Nero 2015 Platinum at
www.nero.com.
Nero CoverDesigner is not installed automatically with Nero 2015. However, it
can be downloaded for free from the Download section at www.nero.com or via
Nero ControlCenter and used together with Nero 2015. Please see the separate
Nero CoverDesigner user manual for full instructions.

Nero WaveEditor is not installed automatically with Nero 2015. However, it can be
downloaded for free from the Download section at www.nero.com or via Nero
ControlCenter and used together with Nero 2015. Please see the separate Nero
WaveEditor user manual for full instructions.

1.4

Working with Nero Burning ROM
The main function of Nero Burning ROM is to select files and folders and to burn them to a
disc. This is done in three basic steps:


In the New Compilation window, select a disc type and the disc format and set the
options on the tabs.



In the selection screen, select files that you want to burn.



Start the burn process.

See also
 Main Screen →10
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 Burn CD/DVD/Blu-ray →20
 Compiling Audio CDs →40
 Mixed Mode CD and CD EXTRA →49
 Burn DVD-Video →66

1.5

Starting the Program
There are several ways to open Nero Burning ROM, depending on various factors such as
the product you have installed and the operating system you are using.


On Windows 7 and earlier versions of Windows, you can start Nero Burning ROM via:



Start (the start icon) > (All) Programs > Nero > Nero 2015 > Nero Burning ROM



the

Nero 2015 desktop icon

The application launcher
Nero 2015 provides easy access to Nero
applications, offers information about the main use cases, and links to tutorials
and other interesting Web sites by Nero.



On Windows 8, you can start Nero Burning ROM via:



the Nero 2015 tile (Windows 8 Start screen) or the

Nero 2015 desktop icon

(Windows 8 desktop) if you use Nero 2015


the Nero Burning ROM tile (Windows 8 Start screen) or the

Nero Burning ROM

2015 desktop icon (Windows 8 desktop) if you use Nero Burning ROM 2015 as a
standalone product
It is also possible to start tasks with Nero Burning ROM from the context menu of
a file or folder.

1.6

System Requirements
Nero Burning ROM is part of the Nero product you have installed. Its system requirements
are the same. Detailed system requirements of this and all other Nero products can be found
in the Support section on our Web site www.nero.com.
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User Interface

2.1

Main Screen
The main screen of Nero Burning ROM is the starting point for all actions. It consists of a
menu bar and a toolbar with buttons and a drop-down menu.

Main window with menu and toolbar

The following menus are available:
File

Provides program facilities such as opening, saving, and closing. You can
also open the setting options for the compilation, update the compilation, and
define configuration options.

Edit

Provides editing facilities for the files in the selection screen such as cutting,
copying, and deleting. You can also display the properties of a selected file.

View

Provides the option to customize the user interface and to refresh the file
browser.

Recorder

Extras

Window

Help

Provides recorder facilities. You can select the recorder here, start the burn
process, and erase a rewritable disc. You can also eject a disc and display
disc information.
Provides the option to convert tracks into other formats and to save the songs
on an Audio CD to the hard drive.
Provides the option to alter the position of the compilation area and browser
area.
Provides help facilities such as opening the help, and shows information
about the application.
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The following configuration options are available in the tool bar of the main screen.
Opens the New Compilation window where you choose a compilation type
and where you can set options for that compilation type as well as burning
and copying.
Opens an existing compilation.
Saves the active compilation.
Cuts selected elements in the compilation (selection).
Copies selected elements of the compilation (selection).
Pastes a selection that was cut or copied beforehand.
Starts Nero MediaBrowser, which you can use to easily find, view and access
media files and add them to your project.
Not available for video compilations (DVD-Video for example) as video
structures are not supported by Nero MediaBrowser.
Starts Nero CoverDesigner, which you can use to create labels and covers.
Information about a current compilation such as title, number, and names of
the files is incorporated into the document data. You will find further
information in the Nero CoverDesigner manual.
Only available if Nero CoverDesigner is installed.
Starts Nero Express. Nero Express is a wizard-driven application based on
Nero Burning ROM. You will find further information in the Nero Express
manual.
Starts the burn process by opening the Burn Compilation window containing
the Burn tab.
Starts the copy process by opening the New Compilation window containing
the Burn tab.
Displays information on the disc inserted, such as contents (if any) and
capacity for instance.
Opens the selected drive.
Shows or hides the file browser.
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Recorder
selection
menu

Displays available recorders.

Opens the Choose recorder window where you select an available recorder
for the burn process from a list.
Opens the Burn Label window where you can create or load a label to print
on the label or data side of a Labelflash DVD.
This button is only available if a recorder that supports Labelflash is
connected.
Launches Nero CoverDesigner to create or load a label to be printed on the
label side of a LightScribe disc.
This button is only available if Nero CoverDesigner is installed and if a
recorder that supports LightScribe is connected.
Displays information on the program and version number.

Access to Nero MediaBrowser and Nero Express is only provided by Nero
Burning ROM as part of Nero 2015.

With Nero CoverDesigner, you can create covers and labels for discs (CDs,
DVDs, etc.).
Nero CoverDesigner is not installed automatically with Nero 2015. However, it
can be downloaded for free from the Download section at www.nero.com or via
Nero ControlCenter and installed together with Nero 2015. You will find further
information in the Nero CoverDesigner manual.

See also
 New Compilation Window →13
 About Bootable Disc →73
 LightScribe →79
 Labelflash →83
 Burn from Disc Image →76
 Erase Rewritable Disc Window →108
 Configuration Options →117
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2.2

New Compilation Window
In the New Compilation window you can select the disc type and configure the options for
the disc format. The window basically looks the same for all disc types. The only difference is
the tabs that are available. When you start Nero Burning ROM, the New Compilation
window opens automatically. You can also open it via the New button.

New Compilation window

If the Image Recorder is not enabled, only those disc types supported by the physical
recorder are displayed in the drop-down menu.
Using Nero Burning ROM you can create image files for disc types that the
installed recorder cannot burn. You can enable this function via the File >
Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

The following entries are available in the selection list:
CD/DVD-ROM/Blu-ray
(UDF)

Audio CD

Creates a data disc; all file types can be burned. The burned
data complies with the UDF standard.
Additionally you can use the Nero DiscSpan feature to
comfortably burn a compilation on multiple discs.
Creates a standard Audio CD that can be played on all (audio)
CD players at least.
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Mixed Mode CD

Creates a CD with data and audio files in a single session.
Usually a data file is followed by one or more audio files for
instance (e.g. soundtrack for PC games).
Older Audio CD players are often not capable of recognizing the
data file and attempt to play it.
Creates a multisession CD with audio and data files that are

CD EXTRA

stored in two sessions. The first session contains the audio files
and the second session the data.
Common CD players play the first session as Audio CDs. The
second session can only be used by PCs with a CD-ROM drive,
it cannot be recognized by a normal CD player.

CD/DVD/Blu-ray Disc
Copy

Copies a source disc to a CD/DVD/Blu-ray Disc.

CD/DVD-ROM (Boot)

Creates a bootable disc.

CD/DVD-ROM/Blu-ray
(ISO)

Creates a data disc, all file types can be burned. The burned
data complies with the ISO 9660 standard.

CD/DVD-ROM
(UDF/ISO)

Creates a data disc; all file types can be burned. The burned
data complies with the ISO and UDF standards.

CD/DVD-ROM/Blu-ray
(SecurDisc)

Creates a SecurDisc disc, that includes data integrity and
reconstruction. Additional SecurDisc features include the
possibility to protect the data on your disc against unauthorized
access with a password, to digitally sign the disc, and to
configure the data redundancy.
Creates a DVD that delivers high-quality playback of video
and/or picture files on DVD players.

DVD-Video

AVCHD (TM) video

BDMV-Video

You can use Nero Burning ROM to burn a DVD if the DVD video
title, i.e. a complete DVD folder structure including premastered
files is already available.
Creates an AVCHD video disc that delivers high-quality playback
of camcorder video and/or picture files on DVD or Blu-ray
players.
You can use Nero Burning ROM to burn an AVCHD video disc if
a complete AVCHD folder structure including premastered files
is already available.
Creates a Blu-ray Movie (BDMV) disc that delivers high-quality
playback of video files on Blu-ray players.
You can use Nero Burning ROM to burn a BDMV-Video disc if a
complete BDMV folder structure including premastered files is
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already available.

In Nero Burning ROM it is not possible to convert video files to DVD-Video, an
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 2015. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.

The actual disc formats that are available and the actual disc types (e.g. DVD) to
which can be written depend on the selected recorder.

A Jump List is provided by Nero Burning ROM under the Windows 7 operating
system. Compilation types, e.g. Audio-CD, can be chosen directly from the Jump
List.

The following buttons are available:
Nero Express

Starts Nero Express. Nero Express is a wizard-driven application
based on Nero Burning ROM.
Only available in Nero Burning ROM as part of Nero 2015.

Open

Opens a file browser where you can find and open a saved
compilation. You can also open an image file in order to burn a disc.

New

Creates the selected compilation and displays the selection screen
where you can select the files for burning.

Cancel

Closes the New Compilation window.

You can set the options for the respective disc format on the tabs in the New Compilation
window.

Which tabs are available depends on the disc type that is selected.

The following tabs are available:
Info
Multisession

Shows statistical information on the compilation.
Contains options for starting and continuing multisession discs.

Nero Burning ROM

15

User Interface

Nero DiscSpan

Autorun

Contains the option for activating the Nero DiscSpan feature. This
allows you to comfortably burn a compilation on multiple discs when
the data to be burned is too large to fit on a single disc.
Contains the option to select a file to be executed automatically when
the disc is inserted into the disc drive.

ISO

Contains options for configuring the ISO file system.

UDF

Contains options for configuring the UDF file system.

Label

Defines the labels of the disc.

Dates

Allows you to define the dates of the compilation and of the
associated files. You can also specify a validity period for the disc.
You can access the data regardless of the validity period specified.

Misc

Defines whether and which files are stored in the buffer memory. If
you posses a LightScribe recorder you can create the label here or
select what is to be printed. For the CD-ROM (ISO) disc type, you can
convert the code for an AVI video here to make it compatible with
Xvid/MPEG -4 or DivX.
We recommend that you only convert the code if you have experience
with FourCC codes and AVI videos.

Audio CD

CDA Options
CD EXTRA

Contains options for configuring audio files.
You can also enter additional information about the CD.
Defines the strategy used by Nero Burning ROM for handling CD-DA
files from a source audio CD.
Contains options for configuring albums.

Boot

Contains options for configuring a bootable disc.

Burn

Contains options for configuring burning.

See also
 Burn CD/DVD/Blu-ray →20
 Compiling Audio CDs →40
 Mixed Mode CD and CD EXTRA →49
 Burn DVD-Video →66

Nero Burning ROM

16

User Interface

2.3

Selection Screen
The selection screen is displayed in the main screen after you select the disc type and
format in the New Compilation window and click the New button. The selection screen
consists mainly of the compilation area and the browser area. Essentially, all selection
screens have the same structure.

Selection Screen

The compilation area (Disc Content) is located on the left side of the screen, and is named
after the relevant compilation. Files and folders are compiled here for burning. In the browser
area (File Browser) on the right side you can find the elements that you want to burn. You
can add data to your projects using the drag and drop function: Drag and drop the elements
from the File Browser area to the Disc Content area.

If the File Browser area is hidden, you can show it again using the

button.

The following setting options are available:

Disc type drop-down
menu

Allows you to select another disc type without loss of
information. The option to change the disc type is useful when
starting a compilation without knowing how much space is
required by the files.
Available for data compilations only.
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Selection list
DVD9 (8.5 GB) /
DVD5 (4.7 GB)

Allows you to expand or shrink the capacity bar according to the
type of DVD you are going to burn. Choose the DVD9 (8.5 GB)
option for a double layer DVD (DVD DL) and DVD5 (4.7 GB) for
a single layer DVD.
Available for all DVD compilations.

Selection list

Allows you to expand or shrink the capacity bar according to the
type of Blu-ray Disc you are going to burn:

BD QL (BDXL) (128 GB)
/
BD TL (BDXL) (100 GB)
BD DL (50 GB) /
BD (25 GB)

BD QL (BDXL) (128 GB) for a quadruple layer Blu-ray Disc,
BD TL (BDXL) (100 GB) for a triple layer Blu-ray Disc,
BD DL (50 GB) for a double layer Blu-ray Disc (BD DL) and
BD (25 GB) for a single layer Blu-ray Disc.

Button
Burn Now

Available for all Blu-ray Disc compilations except BDMV-Video.
Starts the burn process immediately. If you want to check or
select the burn or compilation options again before burning, click
the Burn button in the upper part of the screen.

The bottom margin of the screen contains a capacity scale in MB or GB for data discs or
minutes (min) for Audio CDs. The exact size of the scale will depend on which disc type you
have selected.
Actual capacity of media formats
The actual capacity of the DVD5, DVD9, BD DL, and BDXL media formats is less
than as stated by the disc manufacturers. For example, the actual capacity of a
4.7 GB DVD5 is around 4.38 GB only.
This is because of different conversion systems. A DVD5-media format can
handle 4.700.000.000 bytes, but this number is not equal to the 4.7 GB stated by
the disc manufacturers. The correct conversion factor for bytes is not 1000, but
1024:
1024 byte = 1 KB
1024 KB * 1024 KB = 1 MB
1024 KB * 1024 KB * 1024 KB = 1 GB
A DVD can handle 4.700.000.000 bytes:
4.700.000.000 bytes = 4.589.843 KB = 4.482 MB = 4.377 GB
The capacity bar in Nero Burning ROM will always show you the correct amount
of bytes measured in MB or GB.

When you are compiling files, a capacity bar shows you the estimated size of the selected
files and the available space on the disc. The color of the capacity bar indicates whether the
data will fit on the disc or not:
Green capacity bar

The data will fit on the disc.

Nero Burning ROM

18

User Interface

Yellow capacity bar

Red capacity bar

The data might fit on the disc. The size of the disc that has been
inserted will determine whether the data will fit or not.
The data will not fit on the disc.
(Unless you have inserted an oversize disc.)

The yellow and red marks are set by default for discs that are commercially available. The
disc type you have selected will determine the exact scale value.
Capacity of the CD recordable disc
For example, blank CDs are available with a capacity of 650 MB (74 min) or 700
MB (80 min). Therefore, the yellow mark is set for CDs at 650 MB and the red at
700 MB.

Display the Capacity Bar
If the capacity scale is hidden you can display it again by clicking the File >
Options > Compilation menu and by selecting the check box Show the
compilation size in the Nero status bar.
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3.1

Burn CD/DVD/Blu-ray
With Nero Burning ROM you can compile and burn all types of files and folders. If a Blu-ray
recorder is installed on your computer you can burn data CDs, data DVDs and data Blu-ray
Discs. If you have a CD recorder you can only burn data CDs. The procedure for all data
compilation methods is identical.
The Image Recorder is also suitable for creating an image of a disc type not
supported by the connected recorder. For example, you can therefore create a
DVD image without having installed a DVD recorder. You can then write the
image to a disc at any time.
To create a data disc, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New
Compilation window. (In the case that the New Compilation window is not opened, it can
be opened by clicking the New button on the main screen.)



The selection list shows the compilation types that can be burned.

New Compilation Window

You can select an appropriate disc format without loss of information at any time
in the main screen. Note that this has to be technically possible - for example you
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD
and change later to a data DVD, for example. The possibility to change the disc

Nero Burning ROM

20

Data Disc

type is useful when starting a compilation without knowing how much space is
required by the files.

2. Select the desired compilation type for a data disc from the selection list (CD/DVDROM/Blu-ray Disc (UDF) , CD/DVD-ROM/Blu-ray Disc (ISO), or CD/DVD-ROM/Blu-ray
Disc (UDF/ISO).



The tabs with the configuration options that are valid for this compilation type are
displayed.

3. Set the options you require on the tabs.
Enabling Nero DiscSpan is useful, if the file size of the data to be burned is
larger than the disc size or if you do not know exactly whether the files fit on one
disc. With Nero DiscSpan the files are burned to several discs if necessary. Nero
DiscSpan is only available for UDF-compilations.
Enabling Multisession is useful, if the file size of the data to be burned is much
smaller than the disc size or if you are not sure, if your compilation is complete
yet. With Multisession, you can burn additional content later on.
Note, that you can either enable Nero DiscSpan or enable Multisession.

4. Click the New button.



The New Compilation window is closed and the selection screen is displayed.

Compilation screen

5. Select the files/folders that you want to burn from the File Browser area.
6. Drag the required files/folders into the Disc Content area on the left side.
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The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.
In Nero Burning ROM, there is the option of defining filters for individual files or
folders by dragging files or folders into the compilation areas with the depressed
right mouse button. For instance, it is possible to filter for a particular type of file
(*.doc, *.xls, *.txt) or select which type of file is not to be taken up in the
compilation area.
It is very easy to hide files in data compilations for additional protection or for
security reasons so that they do not appear on the normal display. The files
behave in the same way as other hidden system files that are hidden by default,
but can easily be displayed. To hide files, right-click the required file, select the
Properties option and then select the Hide check box.
Nero Burning ROM supports virtual search folders in the Windows Vista operating
system. The search is selected by dragging the search folder into the compilation
area. If you want to select the files of the search folder, you must open the search
folder and drag the files into the compilation.

7. Repeat the previous step for all files that you want to add.

 You have successfully compiled a data disc and can now burn this compilation.
See also
 Selection Screen →17

3.2

Burn a SecurDisc
SecurDisc is a technology with which you can create discs with special protection properties.
No special hardware is needed.
Discs that are created with Nero Burning ROM and the SecurDisc compilation type include
data integrity and reconstruction. Additional SecurDisc features include the possibility to
protect the data on your disc against unauthorized access with a password, to digitally sign
the disc, and to configure the data redundancy.
To be able to copy the protected data to your hard drive and to check the security of the data
you will need a special application named Nero SecurDisc Viewer. The Nero SecurDisc
Viewer is burned automatically to the SecurDisc disc and can be downloaded free of charge
at www.securdisc.net or www.nero.com.

More information on SecurDisc technology can be found at www.securdisc.net.

To compile a SecurDisc disc, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New
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Compilation window. (In the case that the New Compilation window is not opened, it can
be opened by clicking the New button on the main screen.)



The selection list shows the compilation types that can be burned.

2. Select the desired compilation type for a SecurDisc from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.

SecurDisc Compilation

3. If you want to enable the password protection for all files:
1. Enable the Password protection check box on the SecurDisc tab.

 The SecurDisc – Protect Data window is opened.
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2. Enter the desired password in the Password input area and then click the OK button.
When appropriate, a wizard offers suggestions in an additional Tips dialog box
when entering and selecting the password. The wizard estimates the security
level, i.e. the quality of the password, during entry.

4. If you want to sign the disc with a digital signature:
1. Select the Digital signature check box on the SecurDisc tab.

 The SecurDisc – Digital Signature window is opened.
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2. If you have already created a digital key, click the Browse button and select the key.
3. If you want to create a digital key, click the Start button.

 The SecurDisc – Create Digital Key window is opened.
4. Read the instructions and click the Next button.

 The SecurDisc Key Creation Process window is opened.
5. Move your mouse at random until the creation process is complete.

 Nero Burning ROM uses the random data to create the SecurDisc key. You can
monitor the status of the creation process using the progress bar. The Next button is
enabled as soon as the process is complete.
6. Click the Next button.

 The SecurDisc – Key Creation Completed window is opened.
7. Enter a file name for the key you have created and click the Finish button.

 The SecurDisc – Digital Signature window is opened again and the selected key
appears in the drop-down menu.
8. Click the OK button.

 The corresponding window is opened to inform you that the disc is being digitally
signed with the selected key.
9. Click the OK button.
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You can pass on the relevant public key to recipients to enable them to verify the
signature.

5. If you want to enhance the burning speed by limiting the data redundancy or to configure the
data redundancy:
1. Select the Data redundancy check box on the SecurDisc tab.

 The drop-down menu is enabled.
2. Select the desired redundancy level.
If the Data redundancy check box is disabled, the disc will be filled completely
with copies of the chosen data and checksums. A display panel in the compilation
screen indicates the current redundancy level.
A redundancy level of 1,3 means no redundancy and a redundancy level of 9
means excellent redundancy.
We recommend a redundancy level of at least 2,5.

6. Click the New button.



The New Compilation window is closed and the selection screen is displayed.

SecurDisc Selection Screen

7. Select the files/folders that you want to burn from the File Browser area.
8. Drag the required files/folders into the Disc Content area on the left side.
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The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.
You can selectively enable the password protection for individual files by marking
the desired file in the compilation screen and clicking the Protect button.

9. Repeat the previous step for all files that you want to add.

 You have compiled a SecurDisc disc with settings according to your requirements
and can now burn the disc.
See also
 About Nero SecurDisc Viewer →110

3.3

Burn with Nero DiscSpan
With Nero Burning ROM you can compile and burn all types of files and folders to multiple
discs. The Nero DiscSpan feature for UDF compilations is useful when the data to be
burned is too large to fit on a single disc.
The number of discs to be used is shown in the compilation screen and you can switch the
disc type here. However, during the burn process you are allowed to alternate the disc types
(CD, DVD, Blu-ray Disc) regardless of which disc type you chose at the beginning.
When a single file exceeds the capacity of a disc, Nero Burning ROM can split such files
automatically. In addition, using the SmartFit feature integrated in Nero DiscSpan, Nero
Burning ROM can distribute files dynamically among several discs. The files are distributed
in such a way that the amount of needed discs is minimized by slightly rearranging the order
of files to optimally use the disc space available. Note that you can either enable splitting of
files or enable SmartFit.
The restore tool Nero DiscMerge and a file catalog is burned on the last disc of the set by
Nero Burning ROM. Nero DiscMerge provides an easy way to copy the content of the Nero
DiscSpan discs to your computer. Nero DiscMerge can also merge split files and restore the
original order of the files distributed by SmartFit.

3.3.1 Set Nero DiscSpan Options
The Nero DiscSpan tab provides configuration options for the Nero DiscSpan feature.
The following configuration options are available:
Check box

Enables the Nero DiscSpan feature. The compilation is burned
to multiple discs, if necessary.

Enable Nero DiscSpan Nero DiscSpan can only be enabled, if on the Multisession tab
the No Multisession option button is selected.
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Enables the option that files that exceed a certain file size are
split if this is necessary to fill up a disc space. The original order
Option button / Input field
of the files is being kept.
Allow the splitting of
Note, that you need Nero DiscMerge in order to merge split files
files which exceed
and folders. Nero DiscMerge is automatically burned to the last
disc.

Option button
Allow Nero DiscSpan
without file splitting

Check box
Enable SmartFit

Enables the pure Nero DiscSpan feature (burns the compilation
to multiple discs) without file splitting and without rearranging the
order of files.
Note, that the file size is therefore limited by the disc size at
least.
Enables the option that files are distributed dynamically among
several discs and not necessarily in the original order. The files
are distributed in such a way that the amount of needed discs is
minimized by slightly rearranging the order of files to optimally
use the disc space available. Therefore, it is possible, that files
from one folder are to be found on multiple discs.
The original order of the files can be restored easily by Nero
DiscMerge. Nero DiscMerge is automatically burned to the last
disc.

Check box
Add Nero DiscMerge
and file catalog to
master disc

Adds Nero DiscMerge to the last disc. Nero DiscMerge provides
an easy way to copy the content of the Nero DiscSpan discs to
your computer.
Nero DiscMerge can also merge split files and restore the
original order of the files distributed by SmartFit. Therefore, Nero
DiscMerge is automatically burned to the last disc if the Allow
the splitting of files option or the Enable SmartFit option is
enabled.

3.3.2 Creating Multiple Discs with Nero DiscSpan
With Nero Burning ROM you can compile and burn all types of files and folders to multiple
discs. The number of discs to be used is shown in the compilation screen and you can
switch the disc type here.
In order to minimize the amount of needed discs, you can also split large files or re-arrange
the order of files to optimally use the disc space available.
To create an UDF compilation using the Nero DiscSpan feature, proceed as follows:

1. Select the desired disc format (CD, DVD, Blu-ray) from the drop-down menu in the New
Compilation window. (In case that the New Compilation window is not opened, it can be
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opened by clicking the New button on the main screen.)



The selection list shows the compilation types that can be burned.

2. Select an UDF compilation type from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.

3. Click the Nero DiscSpan tab.



The Nero DiscSpan tab is displayed.

New Compilation - DiscSpan (UDF)

4. Select the Enable Nero DiscSpan check box. Make sure, that on the Multisession tab the
No Multisession option button is selected.
Discs that use the Nero DiscSpan feature cannot be created as multisession
discs.
Nero DiscSpan options
Allow the splitting of files which exceed: A files that exceed a certain file size
is split if this is necessary to fill up a disc space.
Allow Nero DiscSpan without file splitting: The pure Nero DiscSpan feature
(burns the compilation to multiple discs) without file splitting and without
rearranging the order of files.
Enable SmartFit: Files are distributed dynamically among several discs and not
necessarily in original order.
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5. Set the desired options on the other tabs.
6. Click the New button.



The New Compilation window is closed and the selection screen is displayed.

Selection Screen - DiscSpan (UDF)

7. Select the files/folders that you want to burn from the File Browser area.
8. Drag the required files/folders into the Disc Content area on the left side.



The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required by the DiscSpan compilation. On the
left an info field indicates how much discs will be burned.
In Nero Burning ROM, there is the option of defining filters for individual files or
folders by dragging files or folders into the compilation areas with the depressed
right mouse button. For instance, it is possible to filter for a particular type of file
(*.doc, *.xls, *.txt) or select which type of file is not to be taken up in the
compilation area.
It is very easy to hide files in data compilations for additional protection or for
security reasons so that they do not appear on the normal display. The files
behave in the same way as other hidden system files that are hidden by default,
but can easily be displayed. To hide files, right-click the required file, select the
Properties option and then select the Hide check box.

9. If required, you can change the disc type.

 You have successfully compiled a data disc and can now burn this compilation.
During the burn process you will be prompted to insert a new disc whenever
needed. You are allowed to alternate the disc types (CD, DVD, Blu-ray Disc)
regardless of which disc type you chose at the beginning. If you have activated the
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respective option, files which exceed a certain size will be split or files will be
distributed dynamically among several discs.

3.3.3 Copy Data with Nero DiscMerge
The tool Nero DiscMerge was burned on the last disc of the set - the so called Master Disc by Nero Burning ROM. Nero DiscMerge contains information about the content of the burned
Nero DiscSpan disc set. The amount of discs and which file or folder was burned to which
disc is also included in the information. Nero DiscMerge provides an easy way to copy the
files and folders to your hard drive by triggering the copy process and prompting you to insert
the single discs of the set. Using Nero DiscMerge you can be sure, that all files and folders
are copied and no disc is forgotten.
You can also exclude individual files from the copy process or select specific files to be
copied.
Furthermore, Nero DiscMerge can merge split files and folders that have been burned on
multiple discs if the split file feature has been used. If the SmartFit feature has been used,
Nero DiscMerge is useful to copy the distributed files and folders in original order. (If the
SmartFit feature is activated it is possible that files from one folder are to be found on
multiple discs.)
Therefore, we recommend using the comfortable Nero DiscMerge when copying Nero
DiscSpan disc content.
Under Windows Vista and Windows 7 you need administrator rights to save the
files to secure folders such as C:\Program files. Therefore, a User Account
Control message asking for administrator rights may appear with these operating
systems.
To copy the content of Nero DiscSpan discs, proceed as follows:

1. Insert the Master Disc - the last burned disc - into a drive.



Nero DiscMerge starts automatically. The content, i.e. folder structure and files, of the
Nero DiscSpan disc set is displayed.
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Nero DiscMerge

If the program does not start automatically, select the drive with the disc in
Windows Explorer. You can start Nero DiscMerge manually by double-clicking the
NeroDiscMerge.exe file in the $Nero$ folder.

2. Select the copy target in the Target path input field by clicking the Browse button.
3. Select the check box preceding the folder or the file that you want to copy. Select a folder in
the left to show the contained files in the right.

4. Click the Copy Data button.




The Copy Status window is opened.
A message window is opened prompting for the first burned disc.

5. Remove the current disc and insert the first burned disc into the drive.
6. Click the OK button.



The message window is closed and the copy process is started. Information about the
current step is displayed in the information area. A process bar indicates the progress
being made. When the content of this disc is completely copied, then the disc is ejected.
The message window is opened again prompting for the next disc.
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7. Insert each disc of the set in chronological burning order as requested by Nero DiscMerge.



Once the copy process is complete, the message "Disc merging complete" is displayed
in the information area. The Cancel button changes to Close.

Copy Status - complete

8. Click the Close button.



The Copy Status window is closed.

9. Click the Close button.



Nero DiscMerge is closed.
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 You have successfully copied the content of multiple Nero DiscSpan discs to your
hard drive.
If files has been split, they are merged together now. If files have been distributed
dynamically among several discs, they are in their correct folder in original order
now.

3.4

Check Point Media Encryption CD/DVD
With Nero Burning ROM and Check Point Media Encryption you can create discs with
special encryption security protection.
This feature is only available if all of the following requirements are fulfilled:
(1) Check Point Endpoint Security Media Encryption, version R73 or later, is
installed on your computer.
(2) You are allowed to create Check Point Media Encryption CD/DVDs.
(3) You have a special serial number.
The procedure for compiling and burning a Check Point Media Encryption disc is basically
the same as the procedure for compiling and burning data discs. Be sure to select the
CD/DVD-ROM (Check Point) entry in the New Compilation window.
When starting the burn process, a window, which originates from Check Point Media
Encryption, will be opened. After entering security information, e.g. a password for
encryption as defined in your Check Point Media Encryption settings, Check Point Media
Encryption then encrypts the data. When the encryption is finished, the window is closed and
Nero Burning ROM continues the burn process. Depending on your Check Point Media
Encryption settings, a decryption tool is burned on the disc, allowing another user, who does
not have Check Point Media Encryption, to access to the data by entering the password.
The encryption of the data does not take place in Nero Burning ROM. Nero AG is
not responsible for the data encryption and the decryption tool. These features
are provided by Check Point Software Technologies.

3.5

Saving Data Track
With Nero Burning ROM you can save a data disc as an image file. The image file can later
be burned to a recordable disc. The result is a copy of the original data disc.
To save the data disc as an image file, proceed as follows:

1. Insert the data disc in a drive.
2. Click the Extras > Save Data Tracks menu.



The Select Track window is opened. The tracklist shows you the sessions and data
tracks that are found on the disc. Due to the technical reasons, only the first data track of
the first session can be saved.
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3. Select the first data track.
4. Click the Save Track button.



The Save As window is opened.

5. Select a file name and a storage location.
6. In the Save As drop-down menu, select the desired output format (ISO or NRG) for the
image file.

7. Click the Start button.



The Progress window is opened and displays the progress made while saving. When
the save process is complete, the window is closed automatically.

 You have successfully created an image file starting from a data disc. Now you can
burn the image file to a disc.

3.6

Multisession Settings
The Multisession tab provides the option to create multisession discs for data discs.
Multisession discs can be burned in multiple sessions until you have reached the maximum
disc capacity. A session is a self-contained data area that is burned using a single process,
and consists of a lead-in (with the table of contents), one or more tracks, and a lead-out.
Discs without the multisession option, e.g. Audio CDs, are burned in a single session.
If a new multisession disc is being started, Nero Burning ROM also saves (if possible) the
point of origin for the files. This information is used when continuing the multisession disc.
If a multisession disc is being continued, Nero Burning ROM automatically sets a cross
reference to the imported session, i.e. the table of contents for the imported session is
copied to the table of contents for the current session. You must define which session is
being imported when starting your compilation. The files in the previous sessions are
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retained and continue to take up space. Nero Burning ROM automatically verifies whether
the correct multisession disc has been inserted for continuation. If not, the disc is ejected.
You can add new files to the compilation or delete files from the compilation when you
continue the multisession disc. Files and folders from the session to be continued can even
be refreshed, that means, changes in the folders like updated or deleted files can be taken
over to the compilation. In any case, after the burn process the disc gives you access to
exactly these files and folders that were visible in the compilation in Nero Burning ROM.
If you disable the Finalize disc check box on the Burn tab, you can always burn
additional sessions on the disc, but then only the last session will be visible and
you will only be able to access data from the last session.
Multisession disc
Multisession discs are particularly suitable for backing up important files burned
on a regular basis.

Multisession Tab

The following option buttons are available on the Multisession tab in the Multisession area:
Burns the selected compilation in one session to the disc.
If the disc already contains sessions, you can also select this
Start Multisession disc option. Sessions are then not imported and cross references are
not set. This means that only the last session will be visible and
you will only be able to access data from the last session.
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Continues a multisession disc by burning an additional session
to a disc with at least one session. Cross references to the
imported session are set in the process.
Continue Multisession When you select this option, the multisession disc must be
inserted in a drive. You then have to define which session is
disc
being continued. The compilation screen will show the visible
files and folders on the multisession disc, but grayed out.
Everything you see in the compilation screen will be accessible
on the disc later on.
Creates a disc without a multisession.
No Multisession

However, even a disc without a multisession can be continued
as long as it is not finalized. Sessions are then not imported and
cross references are not set. This means that only the last
session will be visible and you will only be able to access data
from the last session.

When selecting the Continue Multisession disc option button, the Options area is
available with the following check boxes:

Refresh compilation
when importing
session

On the multisession disc, Nero Burning ROM has saved (if it has
been possible) the point of origin for the files. If the files can be
accessed on your computer, Nero Burning ROM can refresh the
compilation to match the files at the point of origin.

Replace files in
compilation

If there is a file in the imported session that has been updated
on its point of origin in the meantime, then the outdated version
in the compilation will be replaced with the newest version.

Remove deleted files
from compilation

If there is a file in the imported session that has been deleted on
its point of origin in the meantime, then the file in the compilation
will be deleted, too.

Add new files to
compilation

3.7

Gives you the possibility to refresh your compilation (and
therefore the accessible files on the multisession disc after
burning).

If there is a folder in the imported session, and on its point of
origin a file has been added to this folder, then this file will be
added to the compilation, too.

Burn with Autorun
On the Autorun tab in the New Compilation / Compilation Properties window you can
choose a file to be executed automatically when the disc is inserted into a disc drive (on
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Windows systems). Furthermore you can select an icon to represent the disc in the Windows
Explorer. The icon has to be in the *.ico format, but will be converted by Nero Burning ROM
if you choose another format.
File and icon are selected from the Disc Content area, that means, from the files you have
already added to the actual Nero Burning ROM compilation. So first, you have to compile
your files and then open the Compilation properties window by clicking File > Compilation
Properties. (The window is also opened when you click the Burn button in the task bar.)
Then you can choose file and icon for the autorun execution.

3.8

UDF Settings
The UDF tab provides options for configuring the UDF (Universal Disc Format) file system.
The UDF standard was developed by Osta (Optical Storage Technology Association) in
response to the requirements of DVDs. The standard works on all platforms.
The following setting options are available in the Options drop-down menu:
Entry

Sets options automatically for the UDF file system.

Automatic Settings
Entry
Manual Settings
Entry

We recommend that you select this entry.
Enables you to manually define the UDF partition type and the
file system version.
Creates a disc that is compatible with an Xbox.

Enable Xbox
compatibility mode

This entry is available if the No Multisession option button is
selected on the Multisession tab.

A disc that is compatible with Xbox cannot be created as a multisession disc.

3.9

ISO Settings
The ISO tab provides options for configuring the ISO file system.
ISO 9660 is a system-independent standard. It can be read on all operating systems. The
following features apply:


Permits eight characters plus three characters for the file extension (Level 1) or 31
characters (Level 2) for the file name including the file extension.



Permits eight characters for the folder name.



Restricts the maximum directory depth to eight levels (including root folder).



The characters A-Z, 0-9 and the underscore (_) are permitted.

In the ISO tab, in the area Relax Restriction, the restrictions imposed by the selected file
system can be relaxed. For example, you can allow a higher path level or more than 64
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characters for the Joliet name.
If the disc should be read on all operating systems, select ISO 9660 as the file
system and clear all check boxes in the Relax restrictions area.

An advisory message appears on the ISO tab in the Information area if the disc
cannot be read on all operating systems.
If the disc is to be used mainly on computers with Microsoft Windows and you
want to use lowercase letters and/or foreign language characters for the file
names, select ISO 9660 + Joliet as the file system.

The following setting options are available on the ISO tab in the Data and File areas:

Drop-down menu
Data mode

Drop-down menu
File system

Drop-down menu
Length of file name

Drop-down menu
Character set

Selects the mode for the data. Mode 1 and Mode 2/XA are
available. Newer drives can easily read Mode 1 and Mode 2/XA
CDs.
However, some older drives cannot read Mode 1 discs correctly.
In the case that the disc can to be read in any case on older
drives, select the Mode 2/XA format.
Selects the file system that is used for the data.
ISO 9660 only: ISO format alone is used.
ISO 9660 + Joliet: ISO format is used and is enhanced by the
Joliet standard.
ISO 9660:1999: The latest ISO format update is used. Among
other things it allows the use of 207 characters and a deeper
directory depth.
Defines the possible length of the file name. Level 1 and Level
2 are available. In Level 1 the file name can be eight characters
long and the file name extension (e.g. *.doc) three characters. In
Level 2 the file name can be 31 characters long.
Defines the character set used for ISO names.
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4

Audio CD and Audio Files

4.1

Compiling Audio CDs
Using Nero Burning ROM you can create an Audio CD that contains music files. It can be
played on all standard CD players. To compile an Audio CD, source files with different audio
formats are automatically converted into Audio CD format before being burned.

Some CD players cannot play CD-RWs. Use CD-R discs to burn Audio CDs.

To create an Audio CD, proceed as follows:

1. Select the CD entry from the drop-down menu in the New Compilation window. (In the
case that the New Compilation window is not opened, it can be opened by clicking the
New button on the main screen.)

2. Select the Audio CD compilation type from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.

Audio CD
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3. Set the desired options on the tabs.
Audio CDs should always be burned using the disc-at-once method. This entry is
selected by default.

4. Click the New button.



The New Compilation window is closed and the selection screen is displayed.

5. Select the audio files that you want to burn from the File Browser area on the right side.
You can use the hard drive or an Audio CD as source of the audio file.

You can also choose an M3U playlist as a source.

6. Drag the desired audio files into the Disc Content area on the left side.



The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

Compilation screen - Audio CD

The titles shown here are mostly not identical to the file names. Instead, if there
are song titles saved in the metadata, they will be used. The titles are burned to
the Audio CD as so-called CD TEXT. CD TEXT will be later shown in the CD
player display. So, CD TEXT can only display a limited character set and has also
a length limit.
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7. Repeat the previous step for all audio files that you want to add.
8. Customize the properties of the audio file to suit your requirements.

 You have successfully compiled an Audio CD and can now burn this compilation.
See also
 Selection Screen →17

4.1.1 Customizing Properties of the Audio File
You can display and/or make changes to the audio file properties on the Track Properties,
Indexes, Limits, Splits and Filters tabs of the Audio Track Properties window. To open
the window, mark an audio file in the compilation screen for Audio CDs and click the
Properties button.
4.1.1.1 Track Properties Tab
On the Track Properties tab you will find basic information on the selected file in the
Source information area. To open the window, mark an audio file in the compilation screen
for Audio CDs and click the Properties button.

Audio Track Properties

The following input areas are available in the Properties area:
Input field
Title (CD TEXT)

Defines a title which is saved as CD TEXT. CD players that support
CD TEXT show the title name entered here.
Only Latin characters can be displayed as CD TEXT. CD TEXT can
only be written in disc-at-once mode.
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Input field
Artist (CD TEXT)

Input field
Pause

Defines the artist which is saved as CD TEXT. CD players that
support CD TEXT show the artist's name entered here.
Only Latin characters can be displayed as CD TEXT. CD TEXT can
only be written in Disc-At-Once mode.
Defines the length of the pause in seconds or frames between the
selected audio file and the previous one.

Input field
International
Standard
Recording Code
(ISRC)

Check box
Protection

Check box
Cross fade with
previous track

Identifies the CD title using a 12-character digital code. The ISRC is
entered in the subcode and included silently.
If you do not know the ISRC, you should leave this input field blank.

Sets the copy protection bit for the corresponding track on the Audio
CD. As most CD recording applications simply ignore this bit, copy
protection cannot be ensured. A warning message will be opened in
Nero Burning ROM while copying an Audio CD with copy protected
tracks.
Defines a crossfade between this and the previous audio file. You
can specify the length of the crossfade in seconds or in sectors.

Nero Burning ROM

43

Audio CD and Audio Files

4.1.1.2 Indexes, Limits, Split Tab
On the Indexes, Limits, Split tab you can set and delete indexes and split audio files to
create two or more shorter ones. The tab consists of the Oscilloscope and Positions areas.

Indexes, Limits, Split Tab

Audio files are displayed graphically in the Oscilloscope area. The following configuration
options are available in the Positions area:
Selection lists
Start/End

Button
New Index

Shows the positions for the beginning and end of the audio file on
the CD.
Sets a new index position at the selected position. For the CD player
this is the position from which a new song starts, and the player can
also jump to it directly. However, not all CD players support this
feature.
Opens the Edit track limit dialog box.

Button
Edit
Button
Delete
Button
Split
Button

You can enter the exact position of a split.
Deletes a selected index.

Splits the audio file at the marked position.
Plays the audio file from the marked position.

Play

During playback, the Stop playing button is displayed.
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Button
Stop playing

Stops playback of the audio file.
If playback is stopped, the Play button is displayed again.

Button
Split at Index
Positions
Button
Zoom In
Button
Zoom Out
Button
Full View

Splits the audio file at the set index positions.

Enlarges the graphical representation of the audio file.

Reduces the graphical representation of the audio file.

Displays a graphical representation of the entire audio file.

4.1.1.3 Filters Tab
The Filters tab includes filters that improve or change the quality of the music. The so-called
non-destructive procedure is used for processing, i.e. the actual recording is not changed,
but flags are simply set that can be canceled at any time. No additional audio data is
created. The audio files on hard drive are not modified during this procedure.

Audio Track Properties window, Filters tab
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The following configuration options are available in the Audio Track Properties window:
Check box
Normalize
Check box
Declick
Check box
Hiss Reduction
Check box
Fade In
Check box
Fade Out
Check box
Stereo Widening
Check box
Karaoke
Check box
Echo
Check box
Equalizer

Sets the volume of an audio file to a preset value. This filter can be
useful to bring the volume of files originating from different sources
into line with one another.
Removes clicking and scratching noises, such as those on old LPs
for example.
Reduces or removes the hiss on an audio file. All frequencies
below a certain threshold (hiss level) are removed.
Fades in the volume of an audio file from zero to full volume. This
filter can be useful for shortening files.
Fades out the volume of an audio file from full volume to silence.
This filter can be useful for shortening files.
Increases/reduces the stereo effect of an audio file. This filter only
works if the original file was recorded in stereo.
Fades out the vocals on an audio file. This is done by fading out
the parts of a song that are the same in both stereo channels.
Adds an echo to the audio file.
Opens an equalizer so you can change the volume, bass, and
pitch in different frequency ranges.

Plays the audio file and applies the activated filters. During
playback, the configuration options for the filters can be changed,
Test Selected Filters
allowing the effect to be controlled.

Button

4.1.2 Defining Options
4.1.2.1 Audio CD Settings
The Audio CD tab provides options for setting the Audio CD.
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Audio CD Tab

The following configuration options are available on the Audio CD tab in the General area:
Check box
Normalize all audio
files

Enables a filter that brings the volume of the audio files to be
burned into line with one another. This is particularly
recommended if the audio files originate from different sources.
Allows the audio files to merge into one another on the Audio CD
without a pause (just like in live recordings).

Check box
No pause between
tracks

If the check box is cleared, there are pauses of two seconds
between the audio files.
We strongly recommend using the disc-at-once mode.
Otherwise the zero pause length may not be supported by all
recorders and/or a very short clicking noise may be heard
between tracks.

The following configuration options are available in the CD TEXT area:
Check box
Write on CD

Enables the option for writing CD TEXT. With CD players that
support CD TEXT, the title of the CD, the name of the audio file
as well as the name of the artist appear in the display.
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CD TEXT can only be written in disc-at-once mode.
Input field
Title
Input field
Artist

Defines the label of the Audio CD.

Defines the artist.

You can also enter additional information about the Audio CD such as the producer or
comments.
4.1.2.2 CDA Settings
The CDA Options tab provides options for configuring CD-DA files on the Audio CD. The
CDA file strategy area allows you to select the strategy that Nero Burning ROM should use
for handling selected audio files from a source Audio CD. In general there are two methods:


Read the audio file and store it in the cache temporarily. The Audio CD can be burned in
disc-at-once mode, which supports CD Text.



Create a reference to the audio file and read it shortly before burning (track reference).
The Audio CD can only be burned in track-at-once mode.
To add tracks from a source Audio CD to your audio compilation, we generally
recommend the following alternative:
Rip the source Audio CD to hard drive (see Copy Audio CD to Hard Drive→ 52).
Ideally, save the tracks in the lossless FLAC format. Then proceed by adding the
audio files to the audio compilation.

The following setting options are available on the CDA Options tab in the CDA File
Strategy area:

Drop down menu entry
Diskspace strategy

Drop-down menu entry
Tempfile strategy

Drop-down menu entry
Reference strategy

Saves the audio files temporarily to the Nero Burning ROM
cache.
If there is no space available, a reference is created to the audio
file and is not read until shortly before burning. This entry is
selected by default.
Saves the audio files temporarily to the Nero Burning ROM
cache.
If there is no space available, an error message appears.
Creates a reference to the audio file and reads it shortly before
burning. The source medium can only be a CD/DVD drive, not a
recorder. The disc can only be burned in track-at-once mode.
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Drop-down menu entry
Device dependent
strategy

Creates a reference to the audio file if a CD/DVD drive is
available. Otherwise the tempfile strategy is used.

The following setting options are available on the CDA Options tab in the Drive area:
Selection list
Drive
Drop-down menu
Read speed

Lists recognized drives and burners.

Selects the speed at which the CD is read.

Check box
Cache track on hard
drive before burning

Saves the audio file in the cache before burning.

The following setting options are available on the CDA Options tab in the Advanced area:

Check box

Removes silence at the end of individual audio files, i.e. music
tracks transition smoothly from one to the next. This check box is
selected by default.

Remove silence at the
To avoid unwanted effects set the pause length to 0 when
end of audio tracks
clearing this check box (to set the pause length see Track
Properties Tab→ 42).

4.2

Mixed Mode CD and CD EXTRA
With Nero Burning ROM you can compile CDs that include both audio and data files.
The following compilation methods are available:


Mixed Mode CD



CD EXTRA

A Mixed Mode CD includes the data and the audio files in one session. CD EXTRA includes
the audio files in the first session and the data files in the second session.
The procedure for compiling the audio and data files is basically the same as the procedure
for compiling data or music CDs. Please be sure to select the corresponding entry in the
New Compilation window. The selection screen includes a compilation area for audio files
and one for data files. The compilation can only be burned if files have been added to both
the audio and the data compilation area.
See also
 Selection Screen →17
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 Compiling Audio CDs →40
 Burn CD/DVD/Blu-ray →20

4.2.1 CD-Extra Settings
The CD EXTRA tab provides configuration options for albums.
The following information is available in the Info area:
Display panels

Displays information on the compilation.

The following configuration options are available in the Album area:
Input field
Album identification

Defines a name for the album. This is particularly useful when
the album is to comprise several CDs.

Input field
Number of volumes in Defines the number of discs that the compilation should contain.
album
Input field
Album sequence
number
Button
Pictures

Defines the album number of the current disc.

Opens the CD EXTRA Pictures window where you can select
the pictures for the front and flipside of the CD and define the
picture format.

The following configuration options are available in the Localization area:
Display panel
Languages
Button
Add
Button
Delete
Input field
Album Title

Displays available languages. When you select a language, you
can add the title for the album in the Album title text box. Each
language can contain a different title.
Opens the New Language window where you can select a new
language from a country list.
Deletes the selected language.
Adds an album title to the language highlighted in the
Languages selection list.
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4.3

Gracenote Music Recognition
With Gracenote MusicID Nero Burning ROM can identify music files. So called metadata
such as artist, title, and genre are accessed from the Gracenote Media Database and
displayed in Nero Burning ROM.
Identification is possible for single audio files as well as complete original Audio CDs.
If the metadata of the Audio CD is not yet included in the database then you can enter it and
make it available. The metadata is sent to Gracenote and added into the database.
With Gracenote you can have audio files identified out of any sort of audio compilation. This
is particularly useful when audio files are not named or are only partially named. In this way
your music collection is correctly tagged with all information.
During the following actions, original Audio CDs can be automatically identified in Nero
Burning ROM with Gracenote MusicID.


Copying Audio CD



Saving Tracks from the Audio CD to Hard Drive
Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

4.3.1 Identifying Audio Files
You can have the added audio files in the music compilations identified with Gracenote and
access metadata such as artist and title from the Gracenote Media Database.
To do this, proceed as follows:

1. Select the type of compilation to burn a music CD.



The compilation screen is displayed.

2. Add audio files from the hard drive to the music compilation.
3. Select one or more audio files in the compilation.
4. Right-click to open the context menu.
5. Select the Get metadata entry.



The audio files are analyzed and the required information is sent to Gracenote. The Edit
Meta Data window is opened. The metadata received by Gracenote is displayed in the
New Info area.
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Edit Meta Data window

6. If necessary, edit the metadata, e.g. track number, title, artist, album title, year, and genre.
7. Click the Apply button.



The Edit Meta Data window is closed.

 The metadata is shown in Nero Burning ROM. If the Adjust all file name(s) check
box is selected, the file on hard drive is renamed accordingly (if technically possible).

4.4

Rip Audio CD
With Nero Burning ROM you can save audio files from an Audio CD to the hard drive. In the
process, the files are encoded, i.e. converted into a format that the computer can read. The
audio file is usually compressed.
Nero Burning ROM obtains information about metadata such as title, artist, and track title
from different sources. You can check exactly what metadata will be written into the audio
files.
Metadata about the Audio CD is available from different sources: The Audio CD's own
CD TEXT, Gracenote Media Database and your local database.
▲

The Gracenote Media Database holds metadata about many Audio CDs. With
Gracenote MusicID Nero Burning ROM can identify the Audio CD and access metadata
from the Gracenote Media Database.
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▲

Many Audio CDs contain CD TEXT which includes metadata such as the title of the
CD, the name of an audio file or the name of an artist.

▲

The local database is stored on your PC and contains information for each Audio
CD that was ripped or copied using Gracenote. The local database is useful, when you
change title or artist but don't want to send the changes to Gracenote (because the
changed title makes sense only to you, for example).
Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

Audio files from copy-protected Audio CDs cannot be saved.

To save audio files, proceed as follows:

1. Click the Extras > Save Audio Tracks menu.



The Save Audio Tracks to Hard Drive window is opened.

2. Insert your Audio CD into a drive.



The disc is being analyzed. Metadata information is obtained from Gracenote, CD TEXT
and the local database and displayed, if available.
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Save Audio Tracks to Hard Drive window

3. Select the metadata information for your Audio CD from the CD drop-down menu.
4. Select the tracks that you want to save on the hard drive.
5. Click the Output tab.



The Output tab is opened.

6. Select the target file's audio format in the File Format drop-down menu.
7. Choose a method for creating the file name in the Mode for Creating File Names dropdown menu.

8. Define other settings according to your preferences.
9. Click the Copy button.



Conversion starts. A folder with the album name is created in the desired folder. The
audio files are saved in this folder and named according to the method you chose.

 You have saved audio files.
4.4.1 Save Audio Tracks to Hard Drive Window
Define the settings for audio files to be saved to the hard drive in the Save Audio Tracks to
Hard Drive window. The window is opened by clicking the Extras > Save Audio Tracks
menu.
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The following setting options are available:
Tab
Source
Tab
Output
Button
Copy

Specifies settings for the source of the audio files.

Sets output files configuration options.

Starts the copy or save process.

4.4.1.1 Source Tab
The Source tab displays the audio files on the Audio CD. The functions of the control
buttons correspond to the familiar control buttons on CD players.

Save Audio Tracks to Hard Drive - Source
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The following setting options are available:
Drop-down menu
Source drive

Selects the drive where the Audio CD is inserted.
Selects from which source metadata is used:
Gracenote Media Database

Drop-down menu
CD

CD TEXT
Your local database (only available if you have ripped or copied
the Audio CD before)

Title Selection List

Button
Refresh

Displays the tracks on the Audio CD. You can select individual tracks
to copy by selecting the respective check box.
Obtains all available information again. Nero Burning ROM sends a
new query to the Gracenote Media Database and completes the
Audio CD's metadata including artist, title name, and genre if a
matching entry exists in the database. Also, CD TEXT and
information from your local database, if available, are obtained.

Input fields
Album / Album
Artist / Year
Selection list
Genre
Button

Displays or specifies metadata for the album, album artist and year.

Displays or specifies the genre.
Loads a cover from your hard drive.

Cover

Check box
Submit entered
metadata
anonymously to
Gracenote

Sends changed or newly filled in Audio CD metadata to Gracenote in
order to enter them into the Gracenote Media Database. This
information is also stored in your local database. The local database
is especially useful when you have changed metadata but don't want
to send the changes to Gracenote (because the changes make
sense only to you, for example, or you don't have an Internet
connection at the moment).

4.4.1.2 Output Tab
You can define the properties of the audio files to be created on the Output tab.
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Copy Audio CDs to Hard Drive - Output

The following setting options are available:
Input window
Output directory
Button
Browse
Drop-down menu
Mode for creating
file name
Check box
Automatically
generate a playlist
of stored audio
tracks
Drop-down menu
Playlist format
Drop-down menu
File format

Selects the storage location for the output file.

Opens a browser window where you can select a storage location.

Selects the method to be used for creating the name of the output
file.
Creates a playlist of the saved audio files. A playlist is a list of the
ripped audio files in the right order with the right metadata. It is a
very convenient tool − you simply have to select the playlist to add all
the audio files it contains to an audio compilation or a playback
application.
Selects a format for the playlist.
Selects the output audio format for the selected audio file. The
selected file format is available as the first entry the next time it is
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called up. You can choose between Nero AAC Audio, MP3 Audio,
WAVE, AIFF, FLAC and Ogg Vorbis .

Drop-down menu
Quality

Selects the bitrate for the selected audio file format. If the bit rate is
small, less data is transferred. The file is then small, but quality is
lower. If the bit rate is high, more data is transferred. The file size is
then large, but the quality is high. A value of 128 for MP3 files is near
CD quality. For the MP3 Audio file format you can also select if you
want to create an MP3 file or an mp3PRO file.
Only available if you selected the Nero AAC Audio or MP3 Audio
file format.

Check box

Makes Nero AAC Audio available for an iPod.
Force compatibility
Is only available if you selected the Nero AAC Audio output format.
with iPod
Disables the ID3v2 Unsynchronization during the decoding process.

ID3v2 Unsynchronization is a part of the MP3 decoding process. It
increases the chance that the MP3 file can be played even with old
Check box
software or hardware that does not support ID3v2. However, some
Disable ID3v2
devices that support ID3v2 do not support ID3v2 Unsychronization.
Unsynchronization
The display of images or text tags might be corrupt on such devices
when playing MP3 files with unsynchronized ID3v2. Select the check
box if you have encountered such problems.

4.5

Encode Audio Files
With Nero Burning ROM you can convert an audio file into another format, i.e. transcode the
audio file (e.g. from WAV to MP3).
The following formats are usually available (available formats may depend on the source
format):


AC3: You can specify the bit rate for this audio format



AIFF: See Encoding Options AIFF



FLAC: It is not necessary to specify any settings for this lossless audio format



MP3 (Lame Encoder): See Encoding Options MP3→ 61



MP3/mp3PRO: See Encoding Options MP3/mp3PRO



Nero AAC Audio: See Encoding Options Nero AAC Audio→ 64



OGG: See Encoding Options OGG→ 65



WAV: See Encoding Options WAV



WMA: You can set different profiles for this audio format
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See also
 AIFF and WAVE Encoding Options →60
 MP3 and MP3PRO Encoding Options →62

4.5.1 Encode Files Window
In the Encode Files window, the audio files that are to be encoded are selected and the
properties of the output are defined. You can open the window via the Extras > Encode
Files menu. The window consists of a selection area and the Properties area.

Encode Files Window

The following configuration options are available in the selection area:
List
Files to be encoded
Check box
Show full paths

Displays the selected files.
Displays the full source and destination paths for the files in the
Files to be encoded list.
Opens the browser window where you can select a file to add it to
the list of files to be encoded.

Button
Add

Button
Remove
Button
Remove All

Clicking on the little triangle allows you to select audio files using
Nero MediaBrowser.
Removes the selected file.

Removes all files from the list of Files to be encoded.

Nero Burning ROM

59

Audio CD and Audio Files

Button
Reset Status

Resets the status of the selected file back to Not done.

The following configuration options are available in the Properties area:
Drop-down menu
Output file format
Button
Settings
Display panel
Target file
Button
Browse
Display panel
Source file info

Selects the output audio format for the selected audio file.
Opens a window where you can define options such as bit rate
and frequency for the output audio file.
Displays the storage location of the output file or output files.

Opens a browser window where you can select a storage location.

Displays information on the selected audio file.

The following buttons are available for the encoding process:
Go
Close

Starts the encode process.
Closes the window.

4.5.2 AIFF and WAVE Encoding Options
Nero Burning ROM can encode audio files in AIIF or WAV formats.
Set options in the AIFF/Wave window that you can open in the Encode Files window via the
Settings button. Ensure that you have selected AIFF or Wave as the Output file format.
The following setting options are available in the AIFF or Wave window:
Drop-down menu
Frequency
Drop-down menu
Bits
Drop-down menu
Channels

Specifies the scan rate per second and thus determines the
frequency of scanning. The higher the frequency, the more
frequently scanned.
Specifies the scan accuracy and thus determines the quality of the
individual scanner. The higher the bit sign, the more accurate.
Specifies which channels are recorded.
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4.5.3 MP3 Lame Encoding Options
With Nero Burning ROM you can encode audio files in MP3 formats using the Lame Codec.
Set these options in the MP3 Settings window that you can open in the Encode files
window via the Settings button. Ensure that you have selected Lame MP3 Encoder as the
Output file format.
The following encoding options are available in the Settings area:

Drop-down menu
Constant Bit Rate

Drop-down menu
Variable Bit Rate

Selects a constant bit rate, i.e. the data flow per unit of time and
the quality of the saved data are the same over the entire audio
file. If the bit rate is small, less data is transferred. The file is then
small, but quality is lower. If the bit rate is high, more data is
transferred. The file size is then large, but the quality is high. The
default value of 128 for MP3 files is near CD quality.
Selects variable bit rate, i.e. the data flow per unit of time - and
thus the quantity of the saved data - adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter
points in the track.
Select your desired quality level in the drop-down menu.

The following encoding options are available in the Expert settings area:
Drop-down menu
Encoding quality

Check box
Original bit

Check box
Private bit

Check box
Copyright bit

Check box
Write CRC

Specifies the encoder quality. These settings specify whether you
place more value on fast encoding (lowest/fastest) or more value
on a superior psychoacoustic encoder model for the very best
results (highest/slowest).
Sets the original bit in the music file, which differentiates between
the copy and the original.
Check box selected: Original bit = 1, i.e. original.
Check box cleared: Original bit = 0, i.e. copy.
Sets the private bit in the music file. It is reserved for the user and
is only used for informational purposes.
Sets the copyright bit in the music file, which identifies protected
content.
Check box selected: Copyright bit = 1, i.e. protected.
Check box cleared: Copyright bit = 0, i.e. unprotected.
Sets a checksum in the music file to ensure that transfer errors are
detected.
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4.5.4 MP3 and MP3PRO Encoding Options
With Nero Burning ROM you can encode audio files in MP3 and MP3PRO formats. Set
these options in the MP3PRO window that you can open in the Encode files window via the
Settings button. Ensure that you have selected MP3/MP3PRO as the Output file format.

MP3PRO window

The following encoding options are available in the Settings area:
Drop-down menu
Encoder quality

Check box
Constant Bit Rate

Specifies the encoder quality. Fast, Medium and Highest are
available. These settings specify whether you place more value on
fast encoding (Fast) or more value on a superior psychoacoustic
encoder model for the very best results (Highest).
Selects a constant bit rate, i.e. the data flow per unit of time and
the quality of the saved data are the same over the entire audio
file. If the bit rate is small, less data is transferred. The file is then
small, but quality is lower. If the bit rate is high, more data is
transferred. The file size is then large, but the quality is high. The
default value of 128 for MP3 files is near CD quality.
In the drop-down menu, select the Options that affect the bit rate:
scan rate per second in kBit, scan frequency per second in Hertz
and the channels.

Check box
Variable Bit Rate

Selects variable bit rate, i.e. the data flow per unit of time - and
thus the quantity of the saved data - adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter
points in the track.
Select your desired quality level in the drop-down menu.
Note that not all players are able to show the correct length of MP3
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files that were recorded with variable bit rate.

The following encoding options are available:
Check box
Enable MP3PRO

Button
Expert

Specifies the encoder method used. If you select the check box,
an MP3PRO file is created (*.mp3 file extension).
If you clear the check box, an MP3 file is created (also *.mp3 file
extension).
Opens the advanced area where you can configure Expert
Features.

The following encoding options are available in the Expert Features area:
Check box
Original bit

Check box
Private bit

Check box
Copyright bit

Check box
Write CRC

Sets the original bit in the music file, which differentiates between
the copy and the original.
Check box selected: Original bit = 1, i.e. original.
Check box cleared: Original bit = 0, i.e. copy.
Sets the private bit in the music file. It is reserved for the user and
is only used for informational purposes.
Sets the copyright bit in the music file, which identifies protected
content.
Check box selected: Copyright bit = 1, i.e. protected.
Check box cleared: Copyright bit = 0, i.e. unprotected.
Also sets a checksum in the music file to ensure that transfer
errors are detected.

Check box

Uses a special codec at high frequencies that only saves the
Allow intensity stereo
directional information and volume.
coding

Check box
Allow downmix

Drop-down menu
Padding

Mixes two stereo channels down to one mono signal. This option
is useful when the output data is of such poor quality that a poor
stereo signal is to be expected. An increase in quality is expected
when downmixing to mono.
Selects a padding type for MP3 blocks. We recommend padding
type ISO that pads MP3 blocks according to the ISO specification.
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4.5.5 Nero AAC Encoding Options
Nero Burning ROM can encode audio files in the Nero AAC Audio format.
Set options in the Nero AAC Encoder Settings window that you can open in the Encode
Files window via the Settings button. Ensure that you have selected Nero AAC as the
Output file format.

Nero AAC Encoder Settings

The following setting options are available in the Nero AAC Encoder Settings window:

Drop-down menu
entry
Variable Bitrate

Drop-down menu
entry
Average Bitrate

Drop-down menu
entry
Constant Bitrate

Specifies a variable bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter points
in the track.
You can set the variable bit rate between 0 and 100. 0 means the
lowest, 100 the highest quality.
Specifies an average bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file but the average bit rate tends to the defined value. In
principle is it a variable bit rate with a limited bit band width and thus
combining the advantages of the variable and the constant bitrate.
Specifies a constant bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data is the same over the entire audio
file.
Specifies the bit rate, i.e. the data flow per unit of time and thus the
quantity of the saved data.

Slider
Quality

If the bit rate is small, less data is transferred. The file is then small,
but quality is lower. If the bit rate is high, more data is transferred.
The file size is then large, but the quality is high. The default value of
128 is near CD quality.
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Check box

Encodes the audio files in the M4A audio file format; which was
Use .m4a extension defined by Apple.
for writing files

4.5.6 OGG Vorbis Encoding Options
Nero Burning ROM can encode audio files in the OGG Vorbis format.
Set options in the OGG Vorbis Settings window that you can open in the Encode Files
window via the Settings button. Ensure that you have selected OGG Vorbis as the Output
file format.
The following setting options are available in the OGG Vorbis Settings window:

Check box
Constant Bit Rate

Check box
Variable Bit Rate

Specifies a constant bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data is the same over the entire audio
file.
If the bit rate is small, less data is transferred. The file is then small,
but quality is lower. If the bit rate is high, more data is transferred.
The file size is then large, but the quality is high. The default value of
128 is near CD quality.
Specifies a variable bit rate, i.e. the data flow per unit of time and
thus the quantity of the saved data adapts to the dynamics of the
audio file. The bit rate, for example, can be lowered at quieter points
in the track.
You can set the variable bit rate between 0 and 100. 0 means the
lowest, 100 the highest quality.
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Video

5.1

Burn DVD-Video
With Nero Burning ROM you can burn DVDs made up of DVD-Video files from your hard
drive. You can play your burned DVDs on almost all DVD players.
You can use Nero Burning ROM to burn a DVD Video if the DVD video title, i.e. a complete
DVD folder structure, is already available.
In Nero Burning ROM it is not possible to convert video files to DVD-Video, an
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 2015. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.
To compile a DVD-Video, proceed as follows:

1. Select the DVD entry from the drop-down menu in the New Compilation window. (In case
that the New Compilation window is not opened, it can be opened by clicking the New
button on the main screen.)

2. Choose the DVD Video compilation type from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.

DVD Video Tab
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3. Set the options you require on the tabs.
4. Click the New button.



The New Compilation window is closed and the selection screen is opened.

DVD Video Compilation Screen

5. Select the DVD-Video files that you want to burn from the File Browser area on the right
side.

6. Drag the existing DVD folder structure of the video title (VIDEO_TS) into the Disc Content
area on the left side.



The files are added to the compilation and displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

 You have successfully compiled a DVD-Video and can now burn this compilation.
See also
 Selection Screen →17

5.2

Burn AVCHD
With Nero Burning ROM you can burn an AVCHD video disc made up of AVCHD video files
from your hard drive or camcorder. The AVCHD video disc can be burned to a DVD as
usual, or to a Blu-ray Disc. Burning to a Blu-ray Disc has the benefit that it offers more space
than a DVD.
AVCHD video on DVD is compatible to the specification of a Blu-ray Disc. However,
playback is not guaranteed on all Blu-ray players.
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You can use Nero Burning ROM to burn an AVCHD video disc if the complete folder
structure including premastered files is already available.
In Nero Burning ROM it is not possible to convert video files to DVD-Video, an
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 2015. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.
To compile an AVCHD video disc, proceed as follows:

1. Select the DVD or Blu-ray entry from the drop-down menu in the New Compilation
window. (In case that the New Compilation window is not opened, it can be opened by
clicking the New button on the main screen.)

2. Choose the AVCHD (TM) video compilation type from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.

AVCHD (TM) video - New Compilation Window

3. Enter a name for the AVCHD video disc in the Disc name input field.
4. Click the New button.



The New Compilation window is closed and the selection screen is opened.
It includes the specific AVCHD folder structure.
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AVCHD video - Selection Screen

5. Select the movie that you want to burn from the File Browser area on the right side.
6. Drag the existing folder structure including premastered files into the Disc Content area on
the left side.



The files are added to the compilation and are displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

 You have successfully compiled an AVCHD video disc and can now burn this
compilation.
Files and Folders
The AVCHD video contains different folders. Only certain files are allowed in an
individual folder. If you only have individual files, you must allocate the right files
to the specific folder:
\BDMV\index.bdmv
\BDMV\MovieObject.bdmv
\BDMV\PLAYLIST\*.mpls
\BDMV\CLIPINF\*.clpi
\BDMV\STREAM\*.m2ts
\BDMV\AUXDATA\sound.bdmv
\BDMV\AUXDATA\*.otf
\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be
available)
Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be
available but may remain empty.
If the folder \BDMV\BACKUP is available it contains a copy of the files
index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO.
Additionally, an AVCHD video may contain the folder AVCHDTN. This folder must
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not be available if it is empty. If it is available, it has to contain the following files:
\AVCHDTN\thumbnail.tidx
\AVCHDTN\thumbnail.tdt2

5.3

Burn BDMV
With Nero Burning ROM you can burn a BDMV-Video disc made up of BDMV (= Blu-ray
Movie) files from your hard drive. You can play your burned BDMV-Video on almost all Bluray players.
You can use Nero Burning ROM to burn a BDMV-Video if the complete BDMV folder
structure including premastered files is already available.
In Nero Burning ROM it is not possible to convert video files to DVD-Video, an
AVCHD video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD
video, or BDMV-Video is possible in Nero Video for example. Nero Video is
included in the full version of Nero 2015. More information about Nero Video is
available on the Web site www.nero.com, and more information about video
editing is available in the separate Nero Video manual.
To compile a BDMV-Video disc, proceed as follows:

1. Select the Blu-ray entry from the drop-down menu in the New Compilation window. (In
case that the New Compilation window is not opened, it can be opened by clicking the
New button on the main screen.)

2. Choose the BDMV-Video compilation type from the selection list.



The tabs with the configuration options that are valid for this compilation type are
displayed.
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BD Video Compilation Window

3. Enter a name for the BDMV-Video disc in the Disc name input field
4. Click the New button.



The New Compilation window is closed and the selection screen is opened.
It includes the specific and predefined BDMV folder structure.

BD Video Selection Screen
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5. Select the movie that you want to burn from the File Browser area on the right side.
6. Drag the existing BDMV folder structure including premastered files into the Disc Content
area on the left side.



The files are added to the compilation and are displayed in the compilation screen. The
capacity bar indicates how much space is required on the disc.

 You have successfully compiled a BDMV-Video disc and can now burn this
compilation.
Files and Folders
The BDMV-Video contains different folders. Only certain files are allowed in an
individual folder. If you only have individual files, you must allocate the right files
to the specific folder:
\BDMV\index.bdmv
\BDMV\MovieObject.bdmv
\BDMV\PLAYLIST\*.mpls
\BDMV\CLIPINF\*.clpi
\BDMV\STREAM\*.m2ts
\BDMV\AUXDATA\sound.bdmv
\BDMV\AUXDATA\*.otf
\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be
available)
Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be
available but may remain empty.
If the folder \BDMV\BACKUP is available, it contains a copy of the files
index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO.
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6

About Bootable Disc
With Nero Burning ROM you can create a bootable disc with which the computer can be
started without having to access the hard drive. For this reason a bootable disc is often used
as an "emergency disc" to start the computer if it is not possible to access the hard drive.
Bootable discs are created in accordance with the "El Torito" standard, an extension to the
ISO-9660 standard, which defines the structure of data discs. The disc contains a boot
image and an ISO part. The boot image contains all files that are required to load the
operating system and to start the computer. The ISO part can contain any number of data
files that you can back up using this method.

6.1

Booting Requirements
To ensure that a computer can boot from disc, the start sequence must be set in the BIOS of
the computer in such a way that the drive is addressed first as the boot drive (start sequence
CD-ROM, C, A for instance). In the case of an SCSI CD-ROM drive, this drive must be
connected to an SCSI adapter with a separate BIOS in which settings can be modified
accordingly. (This will only work if there are no IDE hard drives present, as these come
before the SCSI adapter in the boot sequence.)
When booting from a disc, you can only start an operating system that does not write to the
medium, such as "MS DOS" or "Linux". During booting, Microsoft Windows 2000 and
Microsoft Windows XP write to the medium from which they are being booted. This is not
possible with a disc and so the process is canceled and the PC cannot be started.

6.2

Bootable Disc Template
For Nero Burning ROM, the template for creating a bootable disc can be either a logical drive
or a drive image file which contains the contents of a drive as a file sector for sector. If the
template for the bootable disc is a logical drive, the bootable disc will emulate this when the
system is booting. There are three emulation types:


Floppy emulation: This requires a bootable floppy disc for creating the bootable disc. At
startup the bootable disc emulates a floppy disk. In the process, the drive letters
increment, so that Drive A: corresponds to the bootable disc. The volume of the start
data is limited by the capacity of the floppy disk (e.g. 1 MB).



Hard drive emulation: A bootable hard drive is required to create the bootable disc. At
startup the disc emulates Drive C. All drive letters from Drive C increment by one. The
volume of the start data is limited by the capacity of the CD (e.g. 700 MB) or DVD (e.g.
8.5 GB). If, for instance, you have a 200 GB hard drive with only one (200 GB) partition,
you cannot create a bootable disc from it without repartitioning your hard drive
accordingly beforehand.



No emulation: In this process the drive names are not changed. This type is used for
bootable installation CDs. This setting is intended for users who do not require a floppy
or hard drive emulation and who want to install their own device driver.
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6.3

Burn a Bootable Disc
To create a bootable disc, proceed as follows:

1. Click the New button in the main Nero Burning ROM screen.



The New Compilation window is opened.

2. Select the desired disc format from the drop-down menu.
3. Select the desired Boot compilation type.



The tabs for the bootable disc are displayed; the Boot tab is in front.

Boot configuration

4. If the template data for the bootable disc should originate from a logical drive:
1. Select the Bootable logical drive option button in the Source of boot image data area.
2. Select the entry you want from the drop-down menu.
If the logical drive you want does not appear in the drop-down menu, the reason
for this is that the drive is bigger than the space available on the disc. Please note
®
®
that for operating systems such as Microsoft Windows 2000 you need to have
administrator rights in order to be able to access drives directly, which you will
need to do if you are to create bootable discs.

5. If the template data for the bootable disc should originate from an image file:
1. Select the Image file option button in the Source of boot image data area.
2. Click the Browse button and select the desired image file.
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3. Select the Enable expert settings check box and select the emulation type for the
image file from the Kind of emulation drop-down menu if appropriate.
DosBootimage
Nero Burning ROM makes the boot image file DosBootimage.ima available. The
path to the image file is entered in the Image file field by default. You can also
select the language that should appear while the system is booting and select the
correct keyboard layout from the Boot locale drop-down menu.
DosBootimage is an image of the Caldera DOS boot floppy disk and emulates a
floppy disk. The image contains drivers for reading from disc drives and supports
FAT32 (read/write) as well as NTFS (read only). If you choose DosBootimage for
the bootable disc, the expert settings are already predefined.

If you choose an ISOLINUX boot image file, Nero Burning ROM sets the expert
settings automatically correct for ISOLINUX bootable disc.

6. Select any other options required on the tabs.
7. Click the New button.



The selection screen is displayed.

8. Select the files/folders that should be written to the ISO part of the bootable disc and drag
them into the Disc Content area.

 The files/folders are displayed in the Disc Content area and the capacity bar
indicates how much storage space is required on the disc. You have now created
the bootable disc and can start the burn process.
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7

Burn from Disc Image
You can use Nero Burning ROM to burn a disc from a disc image that you have previously
saved on the hard drive.
To load a saved image file, proceed as follows:

1. Select a recorder from the drop-down menu.
2. Click the



button in the main screen.

The Open window is opened.

Open window

3. Select the desired image file and click the Open button.



The Burn Compilation window is opened.
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Burn Compilation window

4. Set the desired burn options.
5. If technically possible, you can change the disc type in the drop-down menu.
6. Click the Burn button.



The burn process is started. A progress bar indicates the progress being made by the
burn process. When the burn process is complete the disc is ejected.
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Burning process

 The burning process is complete. You can now remove the burned disc from the
recorder.
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8

LightScribe
Using Nero Burning ROM and a LightScribe recorder you can create or load labels that you
can burn onto the label side of CDs/DVDs in the LightScribe recorder. The function is
available as a separate Print LightScribe Label option in the start screen or can be
integrated as an intermediate step into the creation and burn process of a project.

This function is only available in recorders that support LightScribe technology.

8.1

Printing LightScribe Label
The process for printing the label is integrated into the burn process. First, the compilation is
burned. You then flip the disc over, and the label is being burned.
It is possible to burn the label several times to the same LightScribe disc. The printed labels
will be aligned. This darkens the label und often improves the quality. It is also possible to
extend the label with new elements in an additional burn process.
The following requirement must be fulfilled:
▲ A LightScribe recorder is selected.
To print a label within your compilation, proceed as follows:

1. Select the desired compilation type in the New Compilation window.
(In the case that the New Compilation window is not opened, it can be opened by clicking
the New button on the main screen.).

2. Click the Misc tab.
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3. Select the Print label check box in the LightScribe area.
4. Click the Create button.



The CD Label Editor window is opened.

CD Label Editor

5. Create your label or open an existing one that you have created with Nero CoverDesigner.
The interface in the CD Label Editor window and the procedure for creating
labels work on the same principle as Nero CoverDesigner. Please see the Nero
CoverDesigner user manual for full instructions on how to make professional
looking covers and labels.

6. Set further options that you require.
7. Click the New button.



The New Compilation window is closed and the selection screen is displayed.

8. Select the files to burn (see Compiling Data Disc→ 20).
9. Insert a blank LightScribe CD with the data side facing down.
10. Click the Burn Now button.



The burn process starts and the compilation is burned. A progress bar indicates the
progress being made by the burn process. When the burn process is complete the disc
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is ejected. A window is opened with the message "Please insert a LightScribe disc
into the drive with the label side facing down".

11. Insert the LightScribe disc into the recorder with the label side facing down and click OK.



The LightScribe Print Properties window is opened and the print process starts. In the
LightScribe Print Properties window a progress bar indicates the progress being
made. When the print process has finished, a window is opened with the message
"Burn process completed successfully".

12. Click the OK button.

 The disc is ejected. You have burned the compilation and printed a LightScribe
label.
See also
 LightScribe Settings →121

8.2

CD Label Editor Window
In the CD Label Editor window, you can create or load a label. The window is opened when
you click the Create button in the LightScribe area on the Misc tab for the current
compilation.
The interface in the CD Label Editor window works on the same principle as
Nero CoverDesigner. Basically, it is irrelevant whether you print the label on
paper or directly onto an appropriate disc. Please see the separate Nero
CoverDesigner user manual for full instructions on how to make professional
looking covers and labels.
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Document - CD Label Editor Window

The following configuration options are available:
Inner radius

Defines the distance between the label and the inner edge.

Outer Radius

Defines the distance between the label and the outer edge.

Width
Label templates

Defines the width of the print area.
Contains a selection of different templates for designing the label.
You can continue to edit and customize a selected template.

New

Generates a new label document.

Open

Opens an existing label which was created using Nero
CoverDesigner.

Save As
OK

Saves the label you have created.
Adds the label you created to the compilation and closes the window.

Preview

Opens the Print Preview window that shows how the label should
appear on the LightScribe disc.

Cancel

Cancels the procedure and closes the window.
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9

Labelflash
If you have a Labelflash recorder, you can print a label on the label and/or data side of the
Labelflash DVD. A Labelflash DVD has a special layer between the top and bottom layers;
this layer can be heated by the laser in the recorder so that images and text can be printed
on the DVD.
The interface in the Burn Label screen works on the same principle as Nero
CoverDesigner. Basically, it is irrelevant whether you print the label on paper or
directly onto an appropriate disc.
Please see the separate Nero CoverDesigner user manual for full instructions on
how to make professional looking covers and labels.

This feature is only available in recorders that support Labelflash technology.

9.1

Burn Label Window
In the Burn Label window you can create or load a label and write it on a Labelflash DVD.
Information on the selected printing quality and rotation speed is displayed on the right-hand
side of the screen. Under Disc type you can see whether the blank disc has been inserted
with the label or data side. Either the Labelflash or the DiscT@2 logo is displayed in the
Burn Label window depending on which side is inserted.

Nero Burning ROM

83

Labelflash

Burn Label Window

The following configuration options are available in the Burn Label window:
Input field
Inner Radius
Input field
Width

Defines the distance between the label and the inner edge.

Defines the width of the print area.
Opens the Labelflash Print Properties window.

Button
Change
Button
Preview
Selection list
Label templates
Button
Burn

This is where you can change the printing quality and the contrast
level and display the changes made directly in the print preview.
Opens the Print Preview window that shows how the label should
appear on the Labelflash disc.
Contains a selection of different templates for designing the label.
You can continue to edit and customize a selected template.
Starts the burn process.

Nero Burning ROM

84

Labelflash

Button
Cancel

Cancels the procedure and closes the window.

If you are creating a DiscT@2, Nero Burning ROM displays only the available
print area for creating the label by default, i.e. the area on the data side of your
DVD that is not already taken up by data. You cannot increase the radius of the
print area.

9.2

Printing Labelflash Labels and DiskT@2
Basically, it is irrelevant whether you print on the label or the data side when creating labels.
The label is actually printed outside the normal burn process.
You can print on the label side of the DVD at any time.
We recommend that you print on the data side first when you have burned the
compilation. It is not possible to burn data on a printed data side. When you insert
a DVD on which data has already been burned, Nero Burning ROM automatically
identifies the space that is still available on the data side and on which you can
print.
To print a Labelflash label on the label side or a DiskT@2 on the data side of your DVD,
proceed as follows:

1. If you want to print a Labelflash label on the label side, insert a blank Labelflash disc into the
recorder with the label side facing down.



The Burn Label window is opened with the Labelflash logo.

2. If you want to print a DiskT@2 on the data side, insert a blank Labelflash disc with the data
side facing down in the recorder.



The Burn Label window is opened with the DiskT@2 logo.

3. Create a label according to your requirements or open a label that you have already created
with Nero CoverDesigner.
The interface in the Burn Label window and creation of a label work on the same
principle as Nero CoverDesigner. See the separate Nero CoverDesigner manual
for full instructions on how to create professional looking covers and labels.

4. If you want to change the area in which the label is printed, change the print area
accordingly using the input fields Inner Radius and Width.

5. If you want to view or change the print properties:
1. Click the Change button.

 The Labelflash Print Properties window is opened.
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2. If you want to change the printing quality, select a quality level from the Print quality
profile drop-down menu.
3. If you select the User defined entry from the Print quality profile drop-down menu, you
can change the contrast level and the rotation speed.
4. Click the OK button.

 The Labelflash Print Properties window is closed and the changes are accepted.

Labelflash Print Properties

6. Click the Burn button.



The labeling procedure starts and the Labelflash - printing or DiscT@2 - printing
window is opened. The window shows the estimated printing time and the print progress.
When printing is complete, a message window is opened informing about the successful
print process.

7. Click the OK button.



The message window is closed and the disc ejected.

 You have successfully printed a label.
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Burn Compilation

10.1 Recorder Settings
In the Choose Recorder window you can select a recorder for burning. You can open the
window via the button which is on the right side of the recorder drop-down menu. The
window shows useful information about the recorder (e.g. supported disc types). In the
advanced area you can set expert options. The available options depend on the chosen
recorder.

Choose Recorder

The following setting options are available in the advanced area:
Check box
Buffer underrun
protection

Check box

Provides buffer underrun protection.
This feature is particularly useful for burning CDs.
Writes an extended lead-out of 515 MB on the second layer of a
double-layer multisession DVD when this area contains less data.
Doing so improves the read compatibility.

Write extended
lead-out on double- This feature is particularly useful for burning a data multisession
layer discs
DVD on a double-layer disc. It is not needed when the DVD is going
to be finalized.
Burns the DVD up to a radius of at least 1.2 inch (~ 30 mm, approx.
1 GB), even when the compilation contains less data. In doing so the
DVD is forced to meet the DVD-Video specification which reduces
DVD high
compatibility mode the possibility of read errors.
This feature is particularly useful for burning DVD-Videos.

Check box
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Check box
BD defect
management

Drop-down menu

Burns the Blu-ray Disc in defect management mode. In doing so the
burner allocates part of the disc so that it is able to burn the data that
has been damaged in a write error once again. BD defect
management reduces the write speed but increases data security.
This feature is particularly useful for burning data Blu-ray Discs or for
burning backups to Blu-ray Discs.
Defines the book type setting for a DVD.

Book Type Settings This feature is particularly useful for burning to a blank DVD.

Four book type settings are available:
Automatic: Automatically selects the most suitable book type for this DVD.
DVD-ROM: Sets the book type to DVD-ROM. Select this setting if the DVD is to
be played on several DVD players or your DVD player has difficulties with selfburned DVDs or of the DVD-, DVD+ or DVD-RW specification.
Physical disc type: Selects the book type which is specified on the DVD.
Current recorder setting: Leaves the book type setting to the recorder.

10.2 Burn Settings
The Burn tab on the Burn Compilation window provides options for the burn process.
Which options are enabled, depends on the chosen compilation.

Burn Tab
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The following check boxes are available in the Action area:
Checks how fast the compiled data can be accessed and
reduces the selected write speed if necessary. This prevents a
buffer underrun.

Check box
Determine maximum
speed

Recorders with a feature to prevent buffer underruns do not
require a speed test.
Not available when saving with Nero Image Recorder.

Check box
Simulation

Check box
Write

Check box
Finalize disc

Simulates burning. In the process the simulation performs all
steps that are also carried out during burning with the
exception of setting the laser beam. A test determines whether
there is a constant flow of data.
Enables the Burn button.
Closes the disc so that you cannot write to this disc anymore.
Depending on the disc format, finalizing may be necessary.
Nero Burning ROM automatically selects this check box for the
relevant disc formats.

Checks the quality of the disc surface after the burn process.
You can use this option particularly when burning backups or
Check box
discs that have to be archived to ensure that the disc surface
SecurDisc Surface Scan does not have any issues and that burning went well.
This check box is only active if Verify written data is selected.

The following configuration options are available in the Writing area:
Drop-down menu
Write speed

Selects the write speed at which the disc is burned.
Selects the method used to burn the disc. The following
methods are available.

Drop-down menu
Write method

Track-at-once: Burns each audio file (track) separately onto
the disc, i.e. the laser is turned off and turned on again after
each audio file.
Disc/Session-at-once: Burns each session of a multisession
disc separately onto the disc.
Disc-at-once/96: Burns the entire disc in one go without
having to turn off the laser between individual audio files. The
disc is finalized after burning.

Input field
Number of copies

Defines the number of discs that are to be burned. The default
is set to one disc.
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Check box
Buffer underrun
protection

Provides buffer underrun protection.
This check box is only available for a CD and if the selected
burner supports a method which offers buffer underrun
protection.

Burns the compilation to multiple disc. When you click the
Burn button, a window is opened in which you can select the
Using multiple recorders desired recorders. The burn process is then carried out
simultaneously on the selected recorders.

Check box

The speed test and simulation are not required for recorders that have a function
for protecting against buffer underruns. Current recorders mostly have such a
feature.
Audio CDs should always be burned using the disc-at-once method. This entry is
selected by default.

10.3 Burn Process
Many CD players cannot read rewritable CDs (CD-RW). You should therefore use
normal CD-ROMs for burning Audio CDs.
To start the burn process, proceed as follows:

1. Choose a recorder from the drop-down menu in the main screen.
2. Insert an appropriate blank disc.
3. If technically possible you can change the disc type in the drop-down menu.
You can select an appropriate disc format without loss of information at any time
in the main screen. Note that this has to be technically possible - for example you
are obliged to burn an Audio CD to a CD. But it is possible to start with a data CD
and change later to a data DVD, for example. The possibility to change the disc
type is useful when starting a compilation without knowing how much space is
required by the files.

4. If you want to check or select the options regarding this compilation type:
1. Click the Burn button in the main screen.

 The Burn Compilation window is opened; the Burn tab is in front.
2. Check or select the options on the individual tabs.
3. Click the Burn button.

5. If you want to start directly, click the Burn Now button in the lower main screen.
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If the Select multiple recorders check box was selected, the Select Recorder window
is opened.

6. Select recorders here and click the OK button.



The burn process is started. On the screen a progress bar indicates the progress being
made by the burn process. You have some options during the burn process.

Burning process

7. If you want to shut down the PC after burning (as long as this is technically feasible), select
the Automatically shut down the PC when done check box.

8. If you want to check the written data after burning, select the Verify written data check box.
9. If you want to check the disc surface after burning, select the SecurDisc Surface Scan
check box.



If the SecurDisc Surface Scan check box is selected, the SecurDisc Surface Scan
Results window is opened.
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Surface Scan window




Nero Burning ROM starts with the surface scan. The results are displayed in realtime.
When the burn process has finished, a message window is opened.

10. If you want to display the extended area with the event log, click the Details button.
11. If you want to start another burn process with the same compilation, click the Burn Again
button.

12. Click the OK button.

 The burning process is complete. You can now remove the burned disc from the
recorder.

10.3.1 SecurDisc Surface Scan Results
On the SecurDisc Surface Scan Results window the results of the surface scan are
displayed in realtime. The scan test is carried out after the burn process when the
SecurDisc Surface Scan check box is selected, either on the Burn tab or in the Burning
process screen.
The surface scan lets you check the quality of the disc with respect to completeness of the
sectors. The test results are displayed both in a graph and in detail in the display panel
below the graph.

Nero Burning ROM

92

Burn Compilation

SecurDisc Surface Scan

The graph shows all sectors on the disc in one chart, with each sector being plotted with a
small square. Each square, i.e. each sector, is displayed in a different color depending on its
status. The Surface Scan area shows the respective percentage of sectors in the following
three categories: Good, Damaged, and Bad in real time while the test is running. The
following colors, i.e. status indicators, are available:
Green

Readable sectors with no errors.

Yellow

Damaged sectors that can still be read using the recorder's internal
error correction feature.

Red

Damaged sectors that cannot be corrected and are consequently
unreadable.

The following display panels are also available in the Surface Scan area while the test is
running:
Progress

Shows the progress of the test, i.e. the percentage of the disc
already scanned.

Position

Indicates continuously the current position of the read head on the
disc.
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Speed

Shows the scanning speed.

The following information is available in the columns in the display panel:
File
Position

Lists the names of the files on the disc in the drive.
Shows the exact position of the file on the disc.

Length

Shows the length of the individual files.

Quality

Specifies the quality of the files. This score is calculated from the
number of errors found.

10.4 Create and Burn a Disc Image
With Nero Burning ROM and the Image Recorder you can create disc images from every
compilation. The NRG image file format can always be selected whereas the ISO image file
format can only be selected from certain compilation types. Nero Burning ROM only enables
the possible image file formats.
The NRG image file format was developed by Nero. In contrast to ISO, NRG can be created
from every disc and compilation type. This means that even Audio CDs or multisession discs
can be saved as an NRG image file.
To create an image file, proceed as follows:

1. Click the New button.
2. Create a new compilation of your choice.
Using Nero Burning ROM you can create image files for disc types that the
installed recorder cannot burn. You can enable this function via the File >
Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

3. Select the files that you want to burn.
4. If you have installed multiple recorders, select Nero Image Recorder from the drop-down
menu.

5. Click the Burn button.



The Burn Compilation window is opened; the Burn tab is in front.

6. Click the Burn button.



The Save Image File window is opened.

7. Specify a file name and a storage location for the image file and click the Save button.
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The image file is created and saved in the selected storage location. On the screen, a
progress bar indicates the progress made while the file is being created. Once the
creation process is over, a message window is opened.

8. Click the OK button.

 The message window is closed and you have successfully created the image file.
See also
 Expert Features →119
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Copying a Disc

11.1 Methods of Copying
Nero Burning ROM can be used for copying discs. There are two methods for this:


On-the-fly



Copy Over Image

Each method has advantages and disadvantages which will depend on your requirements.

11.1.1 On-the-fly Copying
When using the on-the-fly method, insert the original disc into a drive and a recordable disc
into the drive. The original disc in the drive is copied immediately without any time delay to
the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly,
and does not require any additional space on the disc.
In order to be able to use the on-the-fly method, you will need at least two drives: one for
reading the disc and a disc burner for writing. The following requirements apply to the read
drive and disc burner:


The disc burner must feature buffer underrun protection, or the drive must be capable of
delivering the data sufficiently quickly. The read speed should be at least twice as fast as
the write speed.



The read drive must be capable of delivering information on the number and type of
sessions, otherwise Nero Burning ROM may not be able to produce an exact copy.

If you want to copy Audio CDs, we recommend the copy image method because the quality
of the read audio files can suffer depending on the drive.

11.1.2 Copy Over Image
With the copy over image method, an image of the original disc is saved to a file first. The
image file is then burned to a blank disc. Copying using copy over image takes longer, but it
often produces better results.
You must have sufficient storage space to use the copy over image method.
The copy over image method is particularly suitable in the following situations:


Only one drive is available.



You would like to make several copies of the same disc.



You think it likely that read errors may have occurred on the source CD (for example
because it is scratched).



You attach importance to the best possible reproduction (particularly in relation to index
positions and the quality of Audio CDs).
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11.2 Copy a Disc
With Nero Burning ROM you can copy a disc. That means you make an exact copy of a
source disc and burn it to a target disc. If your source disc is an Audio CD, for instance, your
copy will be an Audio CD as well. Depending on your installed burner, you can copy CDs,
DVDs or Blu-ray Discs. The target disc must be the same disc type as the source disc - you
can copy a DVD only to a DVD, for example. In any case, Nero Burning ROM will give you a
message when the disc type do not fit.
If you are not in possession of the copyright for the relevant disc and do not have
authorization from the owner of the copyright, unauthorized copying of discs
violates national and international legislation.
Some discs are copy-protected and cannot be copied. If you are not sure whether
your disc can be copied, activate simulation before commencing the actual
physical burn process.
To copy a disc, proceed as follows:

1. Click the Copy button in the main screen.



The New Compilation window is opened.

Copy Disc window

2. Select the disc format (CD, DVD, Blu-ray Disc) you want from the drop-down menu.
3. Choose the type of disc to be copied (e.g. Audio CD, Karaoke CD, DVD-Video, Data Blu-ray
Disc) from the Profile selection drop-down menu on the Read Options tab.

Nero Burning ROM

97

Copying a Disc

Read Options tab



The read options are optimally set for the particular type of disc.

4. If you want to copy discs using the On-the-fly method:
1. Select the On the fly check box on the Copy Options tab.
2. Select the drive that contains the source disc from the Drive drop-down menu.
3. Insert the source disc into the selected drive.
4. Insert a blank disc into another drive.

5. If you want to copy discs using the Copy Over Image method:
1. Clear the On the fly check box on the Copy Options tab.
2. Select the drive that contains the source disc from the Drive drop-down menu.
3. Insert the source disc into the selected drive.
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Copy Options tab

6. Click the Copy button.



If you are copying via the drive, the copy process starts. If you are using Nero Image
Recorder, the Save Image File message window is opened.

7. Enter a name for your image file in the File Name text box.
8. Select the relevant storage location in the Save to directory tree and click the Save button.



The copy and/or save process starts. You can follow the process status in the status bar.
If you are using a single drive for copying, you will be prompted to remove the source
disc and to insert a suitable blank disc after the image file has been written.

9. Click the Next button.

 You have successfully copied a disc.
11.3 Copy an Audio CD
The CD Information window is displayed after you have started copying an Audio CD. Here,
you can check exactly what metadata will be written on the Audio CD.
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CD Information window

Metadata about the Audio CD is available from different sources: The Audio CD's own CD
TEXT, Gracenote Media Database and your local database:


Many Audio CDs contain CD TEXT which includes metadata such as the title of the
CD, the name of an audio file or the name of the artist.



The Gracenote Media Database holds such metadata about many Audio CDs. With
Gracenote MusicID Nero Burning ROM can identify music files and access metadata
from the Gracenote Media Database.



The local database is stored on your PC and contains information for each Audio
CD that was ripped or copied. The local database is useful, when you change title or
artist but don't want to send the changes to Gracenote (because the changes make
sense only for you, for example, or you don't have an Internet connection at the
moment).

During the copy process, Nero Burning ROM requests metadata from the Audio CD's own
CD TEXT, from the Gracenote Media Database, and from your local database and displays
them, if available. You can select which metadata will then be written to the Audio CD during
the copy process. You can also change the metadata or create new Audio CD metadata.
Another useful feature is that you can start creating a cover for this Audio CD with Nero
CoverDesigner, the metadata will be taken over.
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The following setting options are available:

CD list

Shows the available Audio CD information. CD TEXT and metadata
from the Gracenote Media Database are requested and displayed, if
available. If the Audio CD contains no CD TEXT, at least the track
titles and the duration are displayed.
You can edit the information by double-clicking the text display [F2].

Tracklist of the
currently selected
CD
Button
Create Cover
Check box
Always use
suggested CD
information and
never show this
message again
Button
OK

Shows the audio tracks of the Audio CD. Here, you can see in detail
which information will be used for the copied Audio CD.
You can edit the information by double-clicking the text display [F2].
Opens Nero CoverDesigner. Information such as title, track number,
and names of the audio files is added to the document data.
If you select this check box, Nero Burning ROM will always adopt
Audio CD information automatically. First, CD TEXT is used. If no
CD TEXT is available on the Audio CD, a request is sent to
Gracenote and Gracenote metadata is used. Applying information
automatically has the advantage that copying is executed faster, but
the downside is that you do not know exactly what information is
copied.
Continues copying the Audio CD using the selected Audio CD
metadata.

Music recognition technology and related data are provided by Gracenote®.
Gracenote is the industry standard in music recognition technology and related
content delivery. For more information, please visit www.gracenote.com.

See also
 Source Tab →55

11.4 Methods and Settings
In the New Compilation window, define the options for copying at the beginning of the copy
procedure. You can use the Copy button in the main screen to open the window. The New
Compilation window consists of a drop-down menu, various buttons, and tabs.
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Copy settings

Only those disc types supported by the recorder are displayed in the drop-down menu. If the
recorder can only burn CDs, the drop-down menu is grayed out.
Using Nero Burning ROM you can create image files for disc types that the
installed recorder cannot burn. You can enable this function via the File >
Options > Expert Features menu, Enable all Nero supported disc types for
the Image Recorder check box. The drop-down menu in the Compilation
window then makes available all supported disc types.

The following configuration options are available:
Button
Disc Info
Button
Copy
Button
Cancel

Displays information on the disc inserted, such as contents (if any) or
available capacity.
Starts the copy process.

Closes the New Compilation window.

The following tabs are available:
Image

Gives the path to the temporary image file and provides information
on the speed of the hard drive.
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Copy Options

Contains options for configuring copying.

Read Options

Contains options for configuring reading of the original disc.

Copy

Contains options for configuring the burn process.

11.4.1 Image Settings
The Image tab provides the two areas Image file and Hard drive speed info. The Image
file area is only enabled if the On-the-fly check box is cleared on the Copy Options tab.
The Image tab provides the following configuration options in the Image File area.
Input field

Displays the path of the temporary image file.

Path
Check box

Deletes the temporary image file when the copy process is
Delete image file after
finished.
disc copy
Button
Browse

Opens the Save As window where you can specify a file name
and a directory where the temporary image file should be stored.

The following configuration options are available in the Image tab in the Hard drive speed
info area:
Drive List
Button
Test Speeds

Lists the available hard drives with their free space..
Tests how far the available drives can be accessed and adds the
speed found to the list.
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11.4.2 Copy Options

Copy Options tab

In the Copy Options tag the following configuration options are available in the General
area.
Check box
On-the-fly

Creates the copy using the on-the-fly method.
If this check box is cleared, the copy is created using the copyover-image method.

The following configuration options are available in the Copy Options tab in the source
area:
Drop-down menu
Drive
Drop-down menu
Read speed

Selects the drive for reading the disc.
If a copy over image is created, we recommend that you select
the recorder for reading in.
Defines the speed at which the disc is read in.

11.4.3 Read Options
The Read Option tab consists of several areas. In these areas it is possible to set options
for reading an original disc.
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Read Options tab

The following configuration options are available in the Profile area:
Selects predefined copy settings or a user-defined setting.
Drop-down menu
Profile selection

In the case of predefined copy settings, Nero Burning ROM sets
the configuration options automatically. You can select the
configuration options yourself with a user-defined setting.

The following configuration options are available in the Data tracks area for the CD disc
type:
Check box
Ignore read errors

Check box

Ignores read errors on the original disc and continues the read
process.
If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.
Passes on corrupt sectors anyway (that have caused read errors)
for burning.

Write defect sectors If this check box is cleared, corrupt sectors are not passed on and
remain blank.
Check box
Read sectors in raw
mode

Reads PQ subchannel data.
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Reads all subchannel data during copying. Subchannel data is
Read all subchannel used to save additional information.
data
The burner has to be capable of reading all the subchannel data.

Check box

The following configuration options are available in the Audio tracks area for the CD disc
type:
Check box
Ignore read errors

Check box
Read indexes of
audio data

Ignores read errors on the original disc and continues the read
process.
If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.
Reads the audio file indexes. This is particularly useful for copying
an Audio CD as it makes sure that all index positions of the Audio
CD are copied correctly. The disadvantage is that it increases the
time it takes to analyze a disc before the copy process starts.

Reads all subchannel data during copying. Subchannel data is
Read all subchannel used to save additional information, e.g. CD Text.
data
The burner has to be capable of reading all the subchannel data.

Check box

The following configuration options are available in the Advanced area for the CD disc type:
Check box
Read Media Catalog
Number and ISRC
Check box
Use jitter correction

Reads the media catalog number, a globally unique number for
compilations, and the ISRC (International Standard Recording
Code), a globally unique number for audio recordings.
Jitter corrector removes scratches from audio and video files.

The following configuration options are available in the Error correction area for DVD and
Blu-ray Disc:
Option button
Read with error
correction
Input field
Read retry count

Performs error correction while reading. In the process, the
checksum of a corrupt sector is adjusted so that the sector in itself
is consistent.
Establishes the number of attempts that are made to correct
errors.

Option button
Fast reading without Performs fast reading without error correction.
error correction
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The following configuration options are available in the Handling of non-correctable read
errors area for DVD and Blu-ray Disc:
Check box
Ignore read errors

Ignores read errors on the original disc.
If this check box is cleared, Nero Burning ROM may interrupt the
burn process depending on the type of error.

With Audio CD, read errors often have little or no impact because they are not
perceptible when the CD is played.
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Erase Rewritable Disc Window
Nero Burning ROM can be used to erase rewritable discs, i.e. discs with the RW
specification, as long as your recorder supports this feature. Two erase methods are
available for this purpose:
Quick erasing does not remove the data physically from the disc, but instead only makes it
inaccessible by erasing the references to existing content. The data can be restored!
Full erasing removes the data from the disc by overwriting it with zeros. The contents cannot
be restored with conventional methods. Repeated full erasing increases the probability that
third parties will not be able to reconstruct the contents.

Erase Rewritable Disc window

The following configuration options are available in the Erase Rewritable Disc window:
Selection list
Select recorder
Check box
Use multiple recorders

Defines the desired recorder.

Simultaneously erases CDs/DVDs in multiple recorders.
Defines the erase method. Two options are available:

Selection list
Select the erase
method to be used

The Quick-erase rewritable disc method does not physically
erase all data from the disc, but only the references to the
contents. The disc will appear to be empty even though the data
is still physically available. Erasing a disc using this method
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takes between one and two minutes.
The Full-erase rewritable disc method physically erases all
data from the disc. The contents cannot be restored with
conventional methods. Repeated full erasing increases the
probability that third parties will not be able to reconstruct the
contents. Erasing the disc using this method takes longer than
the other method, depending on the type of disc involved.
Selection list
Erase speed
Button
Erase
Button
Cancel

Defines the erase speed.

Starts the erase process.

Cancels the action and closes the window.
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About Nero SecurDisc Viewer
Nero SecurDisc Viewer is a standalone application that is part of the SecurDisc technology
platform. SecurDisc is a technology developed by Nero and HLDS to create discs with
special protection properties. No special hardware is needed.
Nero SecurDisc Viewer is available as a free download at www.securdisc.net or
www.nero.com and is also included automatically in a SecurDisc disc that is burned with
Nero Burning ROM or Nero Express.
Discs that are created with Nero and the SecurDisc compilation type include data integrity
and reconstruction. Additionally the data on the SecurDisc disc can be protected against
unauthorized access by using a password. The data can also be digitally signed. Nero
SecurDisc Viewer allows you to copy the protected data to your hard drive and to check the
security of the data.

More information on SecurDisc technology can be found at www.securdisc.net.

See also
 Burn a SecurDisc →22

13.1 Starting Nero SecurDisc Viewer
Nero SecurDisc Viewer is included automatically in a SecurDisc disc that is burned with Nero
Burning ROM or Nero Express. Insert the SecurDisc disc in a drive to open Nero SecurDisc
Viewer automatically.
Nero SecurDisc Viewer can also be opened by double-clicking the
NeroSecurDiscViewer.exe file. This file can either be found on the SecurDisc disc or it can
be downloaded from www.securdisc.net or www.nero.com.
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Main screen

13.2 Copying Data to Hard Drive
With Nero SecurDisc Viewer you can copy the files from the SecurDisc disc to your hard
drive. If the files have been protected against unauthorized access, you can insert the
password here.
Proceed as follows:

1. Select the check boxes of the files you want to copy to the hard drive.
2. Click the Save to button.



If data on the SecurDisc disc is password-protected, the Password Protection window
is opened.

3. Enter the password in the text box and click the Apply button.



An explorer window is opened.

4. Select the required folder and click the OK button.



A progress window is opened and the files are copied. As soon as the copy process is
finished, a message is displayed to notify you.

 The selected files are copied to the selected folder.
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13.3 Checking Data Integrity
Nero SecurDisc Viewer can be used to check the data integrity of a SecurDisc disc by using
the checksum feature. The data integrity check warns you if the data on a disc is at risk of
disc decay so that you have time to back it up to another disc.
Proceed as follows:

1. Click the Integrity button.



A progress window is opened and the integrity check is carried out. You can follow the
progess with the status bar and the displayed messages.

 As soon as the integrity check is finished, a message is displayed to notify you about
the result of the check.

13.4 Checking Signature
With Nero SecurDisc Viewer you can verify the authenticity of the SecurDisc disc if it is
digitally signed. You need the public key from the distributer of the SecurDisc disc for this
purpose. By checking the public key, Nero SecurDisc Viewer is able to confirm that the data
is authentic and has not been manipulated.
Proceed as follows:

1. Click the Signature button.



An explorer window is opened.

2. Select the public key (*.bpk) which the SecurDisc disc is signed with.
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Public key
The creator of the SecurDisc disc has also created or selected the public key for
the disc. The key is to be distributed by the creator of the disc, too.

3. Click the OK button.




The explorer window is closed and the Check window is opened.
The signature is checked. You can follow the progess with the status bar and the
displayed messages.

 As soon as the copy process is finished, a message is displayed to notify you about
the result of the check.
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Nero MediaBrowser
Nero MediaBrowser is a tool which you can use to easily find, view and access media files
and add them to your project. More precisely, with Nero MediaBrowser you can access a
media library which contains all your media files that were indexed by Nero MediaHome.
Nero MediaBrowser and the media library come with Nero MediaHome and are
installed together. You will find further information in the Nero MediaHome
manual.
Nero MediaBrowser is designed to be accessed in several Nero applications, but is also
available as a standalone application.

Nero MediaBrowser

To use Nero MediaBrowser within a Nero application, open Nero MediaBrowser via the
button. When you double-click a media file or select it and click the Add button in Nero
MediaBrowser, the media file will be added to your current project.
To use Nero MediaBrowser with a non-Nero application, open Nero MediaBrowser via the
Windows start menu or its tile, depending on your operating system. You will then be able to
add media files to any active application by dragging the desired media file onto the
application. When you double-click a media file in Nero MediaBrowser, it is opened in its
default program.
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Nero MediaBrowser features the same categories (Photos & Videos, and Music) as Nero
MediaHome. There are different views available for each category: Clicking one of the
entries in the upper part of the list (for example Faces) displays the same view as when
clicking the corresponding tabs in Nero MediaHome. Also, the same scroll bar as in Nero
MediaHome is used. This is either the standard scroll bar or the dynamic scroll bar.
The following views are available for the Photos & Videos category, referring to the
corresponding views in Nero MediaHome:
All Photos &
Videos

Faces

Find
Album

Displays all photos and videos sorted in chronological order by
creation date.
Displays all photos in which faces of persons have been detected
and named listed in alphabetical order. Faces are grouped into
stacks; you can access one of the stacks by double clicking it.
Displays all existing tags enabling you to create a query.
Displays the content of smart albums (e.g. Recently added) and
user generated albums.

The following views are available for the Music category, referring to the corresponding
views in Nero MediaHome:
Albums

Displays all audio tracks sorted in alphabetical order by album.

Artists

Displays all audio tracks sorted in alphabetical order by artist.

Genres

Displays all audio tracks sorted in alphabetical order by genre.

Titles
Playlist

Displays all audio tracks sorted in alphabetical order by title.
Displays the content of smart playlists (e.g. Recently played) and
user generated playlists.

The Options window is opened when you click the

button on the upper task bar. The

options refer directly to Nero MediaHome.
Displays the Library settings area.

Library

All monitored folders are displayed in the respective Watched
folders or drives area. If you want to add additional media folders,
click the Add Manually button and select the desired folder from the
navigation tree. Click the Add Automatically button to have Nero
MediaHome perform a search for new media folders on your
computer. To exclude certain media types (music, videos, or photos)
from a folder, click the respective button to the right of the folder. To
delete a folder from the application's watchlist, hover your cursor
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over the listed folder and click the

button.

You can also just drag files or folders to Nero MediaHome. A window
automatically opens and asks if you want to add the folder(s) to the
library.
In the General area you can select to list your external playlists
(such as iTunes) as entries in the navigation tree of Nero
MediaHome.
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Configuration Options
You can define options for working with Nero Burning ROM in the Options window.

Options Window

The following tabs are available:
Compilation
Cache
Font
Sounds
Expert Features

Database
Ultrabuffer
File Browser

Contains options for the compilation and the selection screen.
Contains options for the cache.
Contains selection options for the font.
Contains selection options for sounds in connection with burn tasks.
Contains options for configuring overburning and burning.
We recommend that you retain the default settings.
Selects the default naming method for audio files to be saved from
an Audio CD to the hard drive.
Defines the size of the RAM buffer.
Contains options for configuring the file browser.
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Misc.

LightScribe

Contains options for configuring compilations, burning, the database,
the user interface, as well as advanced settings.
Contains options for configuring LightScribe recorders such as the
print contrast (quality), default drive, and default template.
This tab is only available if a LightScribe recorder has been installed.

15.1 Compilation Settings
The following configuration options are available on the Compilation tab:
Check box
Start with new compilation

Check box
Remember name of last used
disc

Opens the New Compilation window automatically
when starting Nero Burning ROM.
Uses the Disc name of the last compilation for a new
compilation.
If the check box is cleared, the Disc name is set to New
for a new compilation.

Check box
Show compilation size in the
Nero status bar

Displays the storage volume of your files in a status bar.

Clears the archive bit of the source file (e.g. from the
Check box
Clear archive bits of written
files during ISO refresh

Check box
Allow semicolons in Joliet
names
Check box
Show original path with ISO
compilation

hard disk) as soon as the burn process has finished.
Clearing of the archive bit is of informational value and
indicates that this file has been archived.
If this check box is deactivated, the archive bit of the file
remains unchanged.
Allows the use of semicolons in addition to standard
uppercase and lowercase letters and Unicode
characters in file names in the Joliet file system.
Lists the full path of the added files in the compilation
screen in the Source column.
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15.2 Cache Settings
The following configuration options are available on the Cache tab:
Displays the path of the Cache memory.

Input field

You can enter the path manually or select the path in
the browser window.

Path for cache

Opens a browser window.

Button

You can select a folder in which data is buffered before
and during the burn process.

Browse
Input field

Defines the minimum storage volume on the cache drive
Minimum space on hard drive,
that is not used by Nero Burning ROM.
which Nero should not use

Check box
Immediately cache files that
have been copied from an
optical drive

Saves files that have been added to the compilation
from a source disc in a temporary directory.
If you clear this check box then you have to insert the
original source disc during the burn process.

15.3 Expert Features
The following configuration options are available on the Expert Features tab:
Check box
Enable Disc-at-once CD
overburning

Enables the option that CDs can be overburned.

Drop-down menu / Input field
Absolute/Relative maximum
overburning size
Check box
Enable DVD overburning
Drop-down menu / Input field
Maximum DVD size

Defines how much a CD can be overburned.

Enables the option that DVDs can be overburned.

Defines how much a DVD can be overburned.

Check box
Enable generation of short
lead-out

Enables the option to write additional data to your CD.
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Check box
Do not eject the disc after the
burn is complete

Enables the option that your disc remains in the
recorder and is not ejected when the burn process is
finished.
Enables the option that all supported recorder formats
for the Image Recorder are available.

Check box

It is now possible to create compilations that the
Enable all Nero supported disc
installed recorder cannot burn. For instance, you can
types for the Image Recorder
create a Blu-ray compilation without a Blu-ray recorder
and create an image file with Nero Image Recorder.

Check box

Renames the file extensions to fit the AVCHD
Enable automatic renaming of specifications. AVCHD content on optical discs requires
four letter extension to be detected as an AVCHD disc.
AVCHD file extensions

Area
Nero burn functions in the
context menu

Area / Button
Restore

Allows Nero Burning ROM to be started from the shell
context menu. The shell context menu offers various
pertinent information and is opened by clicking a file or
folder with the right mouse button in the Windows
Explorer.
Resets all settings back to the original factory settings.

Overburning
Overburning means writing more data on the disc than originally intended. It is
achieved by reducing the lead-out area to a few seconds, which is sufficient in
most cases. However, this violates the CD standard and may result in recording
and playback errors (depends on the used recorder).

15.4 Ultrabuffer Settings
The following configuration options are available on the Ultrabuffer tab:
Defines the memory capacity that Nero Burning ROM
uses as a RAM buffer.

Selection list
Method

The ultrabuffer is a second memory that enhances the
physical buffer in the recorder.

Input field
Data buffer size

Defines the memory capacity that can be manually
entered.
The input field is only enabled when Manual
Configuration is selected in the selection list.

Nero Burning ROM

120

Configuration Options

15.5 LightScribe Settings
The following configuration options are available on the LightScribe tab:
Area

Adjusts the desired print quality.

Print contrast
Selection list
Default LightScribe drive
Selection list

Specifies the genre.

Genre
Selection list

Defines a template for labels.

Current template
Selection list
Default print resolution (DPI)

Check box

Selects the drive with the LightScribe recorder.

Adjusts the desired print resolution.
Offers the option to create and burn a LightScribe label
automatically when burning with a LightScrive recorder.

Always print LightScribe label This tab is only available if a LightScribe recorder has
been installed.
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AIFF
The Audio Interchange File Format is an uncompressed audio file format from Apple® and
represents a sort of counterpart to the WAV format from Microsoft. Files are larger than
when using a compressed format, but the quality is higher. AIFF compressed is the
compressed variation.

Archive Bit
Archive bits are used to identify files that have been edited. A file is only resaved during the
next backup process if it was edited (and an archive bit is thus reset).

AVCHD
AVCHD is an HD capturing format for camcorders. It is used for DVDs but compatible to Bluray Discs.

Book Type
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to
ensure correct playback, the DVD specifications are defined in books so that all media can
be read correctly. The specifications are defined in the so-called Rainbow Books, which are
distinguished by means of their color (e.g. Yellow Book).

Bootable CD
Booting refers to loading the operating system when a computer is started. This is normally
done from the hard drive. However, if you do not want to boot or cannot boot your computer
from your hard drive for whatever reason, you can load an operating environment from the
drive with a boot CD.

Buffer
A buffer refers to temporary memory that records and delivers data that cannot be processed
immediately as required. The buffer also allows for continuous data flow.

Buffer Underrun
A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the
recorder). A buffer underrun results from an interruption in the data flow to the internal buffer.
The buffer continues to deliver data until it is finally empty. When recording, data is fed
continuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow
of data is interrupted, the media becomes unusable. Most modern recorders have a
protective mechanism against buffer underruns.

Cache
Cache is a faster buffer that is used in various areas of a computer to access larger data
volumes faster. Cache ensures a continuous flow of data.
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CD-R
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard
defines the storage of audio data and other computer-readable data.

Codec
The compressor/decompressor encodes the data for recording or saving digitally and then
decodes it for playback. Various software codecs are available such as Cinepak, Indeo,
Quicktime, Video for Windows, etc. Hardware codecs include MPEG, H.261, Motion JPEG,
etc.

Disc-At-Once
Disc-At-Once refers to a method in which the laser in your disc burner burns the disc in one
pass without turning off and on between each track. This method is best when recording
Audio CDs you would like to play in your home or car stereo.

Frame
With an Audio CD, 75 sectors provide one second of played music. One sector consists of
up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, "frame"
describes a full screen in television and video technology. Two successive half images result
in a full screen within a second due to interlacing.

Image
An image refers to a single file on the hard drive that contains the image of a complete disc.
A disc image can be used to create exact copies on media at a later point in time if problems
occur during the write process or if no recorder is connected to your PC. The image requires
as much free space on the hard drive as the contents of the original disc take up.

Jitter
Jitter refers to an abrupt and undesired change in the signal characteristics. Small gaps
occur in the data stream as a result. Audio correction synchronizes the data by overlapping
the sectors. This way, the gaps are not audible.

Joliet
Joliet refers to an extension of the ISO-9660 standard for file names. Joliet was designed by
Microsoft in order to represent more characters. The file name can be up to 64 characters
long and contain the letters A-Z, a-z, umlauts, as well as characters from Chinese,
Japanese, and Korean.

Label
A label refers to a label on a disc. Some drives, e.g. drives that use LightScribe or Labelflash
technology, can transfer labels directly to special media.

Labelflash
Labelflash is a technology with which pictures and texts can be burned on the label or data
side of a disc with a laser.
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LightScribe
LightScribe is a technology with which pictures or texts can be burned on the label side of
discs with a laser.

MP3
The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a
fraction of their original size (factor 1:10) with little loss of quality. You can estimate about 1
MB per minute as opposed to 10 MB for the original files. This value and the quality can vary
depending on the complexity of the audio signal. The bit rate used can be used as a
measure of quality. The higher the bit rate, the better the quality, but also the more memory
required.

mp3PRO
mp3PRO is an MP3 codec that compresses audio files even more but in lower bit rates and
better quality. 64 kBit/s in mp3PRO is the equivalent to 128 kBit/s in MP3.

Multisession
A multisession refers to completing a disc in multiple cycles. After a first session has been
written to the disc, information can then be added in another record because the disc has not
been finalized.

Nero AAC
Various MPEG-4 video and audio codecs are collated in Nero AAC and are fully compatible
with the standard MPEG-4. Nero AG is continuing to develop these. In this way a
substantially higher quality of the multi-media data is achieved. Further, additional features
such as subtitles have been implemented.

Ogg
The container format Ogg contains digitalized or compressed multimedia files that have been
encoded with the Vorbis method. Ogg Vorbis is an open source encoder.

Sector
A sector is the smallest addressable information unit on a disc. A sector is composed of
2,352 bytes, of which - depending on the type of disc used - different amounts are available
as user data. A sector generally consists of a header, synchronization bits and user data. It
may also have error recognition and correction data.

Track-At-Once
Track-At-Once refers to a write method in which each track is written to the disc individually.
The writing process is interrupted briefly after each track, i.e. the laser starts again for each
track. With this write method, it is only possible to continue writing to a DVD sometimes and
at a later stage. There is a pause of at least 27ms between tracks, which can be disruptive
for Audio CDs.
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WAV
The WAV audio format, also called WAVE or Waveform audio format, is an audio format
from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from
Apple.
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